Hyperion® Enterprise®

Installation Guide
RELEASE 6.5.1.1.000
# Contents

## Documentation Accessibility

8

## Chapter 1. Installation Overview

9

Introduction ......................................................... 11
Components ......................................................... 11

## Chapter 2. Planning the Installation

13

System Requirements .................................................. 13
Windows Client Workstation Requirements ............................... 13
File Server Requirements (Without Data Server) ............................ 15
File Server Requirements (With Data Server) .............................. 15
Hyperion Enterprise Web Client ....................................... 16
Hyperion Enterprise Web Server ....................................... 16
Application Server Requirements for Hyperion Enterprise ................. 17
Message Server Requirements for Hyperion Enterprise ................. 18
Hyperion Enterprise Smart View Provider Requirements ............... 19
Prerequisites ......................................................... 19
Additional Prerequisites ................................................ 21
Hyperion Enterprise Application Server ................................ 21
Using Hyperion Enterprise Application Server on Windows 2008 32 or 64-bit ...... 21
Statutory Consolidation Engine ........................................ 21
Hyperion Enterprise Servers .......................................... 22
Hyperion Enterprise Web Server ....................................... 23
Hyperion Enterprise Smart View Provider ................................ 25
Components and Their Directories ..................................... 25
Installation Tasks .................................................. 26
Compatible Products ............................................... 27
Port Numbers Used by Hyperion Products ................................ 27

## Chapter 3. Quick Install and Silent Mode Installation

29

Installation Methods ................................................... 29
Performing a Quick Install .............................................. 29
Silent Installation ...................................................... 31
Performing a Silent Mode Installation ................................... 31
Driver Count Settings .......................................................... 32

Chapter 4. Installing Hyperion Enterprise ................................................. 33
Setup Options ........................................................................... 33
Performing a Complete Installation ........................................... 33
  Beginning a Complete Installation .......................................... 34
  Setting Up Server Components ............................................. 45
  Installing Common Security Services (CSS) .............................. 53
  Finishing a Complete Installation .......................................... 56
Performing a Workstation Setup Installation .............................. 57
Verifying Your Path ............................................................... 66
Driver Count Setting ............................................................... 66

Chapter 5. Additional Installation Procedures ....................................... 69
Setting Up Hyperion Retrieve ................................................... 69
  Setting Up Hyperion Retrieve for Microsoft Excel ...................... 69
Creating a Customized Setup Program ...................................... 69
Installing Hyperion Enterprise Using the Customized Setup Program .................. 71
Configuring Hyperion Enterprise Web Server ............................. 71
  Prerequisites ......................................................................... 71
  Configuring the Hyperion Enterprise Web Application ............... 72
Disabling Access to Hyperion Enterprise Web Applications ............ 73
About Hyperion Home ............................................................. 74
  Changing the Hyperion Home Location ................................... 74

Chapter 6. Converting Your Application to Hyperion Enterprise Release 6.5.1.1.000 ............ 75
Feature Comparison with Hyperion Enterprise SE Release 4.x .................. 75
Compatibility of Earlier Hyperion Enterprise SE and Hyperion Enterprise 6.5.1.1.000 Releases ............................................................................................................................. 79
  Performing Eliminations When Substructures are Used .............. 79
  Assigning Formulas to Subaccounts by Equating Major Accounts ............................................. 80
  Calculating Formulas .............................................................. 80
  Entering Intercompany Transactions ....................................... 80
  Tracking Acquired and Disposed Dates .................................... 81
  Universal Naming Convention ............................................... 81
  System Load File Behavior .................................................... 81
Requirements Comparison with Hyperion Enterprise SE .................... 83
  Hyperion Enterprise SE Architecture ..................................... 84
  Hyperion Enterprise Release 6.5.1.1.000 Architecture ................ 84
Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program website at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support

Oracle customers have access to electronic support through My Oracle Support. For information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.
Oracle's Hyperion® Enterprise® is an advanced management, reporting, and consolidation system. This guide describes the hardware and software requirements and installation procedures for installing Hyperion Enterprise.

Hyperion Enterprise handles a wide range of financial management tasks in a graphical, user-friendly environment. You can use Hyperion Enterprise to collect, consolidate, analyze, and report on business and financial information. With Hyperion Enterprise, your file-based applications can be Web-enabled, giving users access to an application onsite or at a remote site using the Internet or an intranet. The system administrator controls which applications are Web-enabled.

External authentication may be used to configure users in Hyperion Enterprise. You can use any or all of the following authentication types: Microsoft Windows NT LAN Manager (NTLM), Lightweight Directory Access Protocol (LDAP), or Microsoft Active Directory (MSAD). Information about the selected authentication service is configured by the administrator after the installation. Multiple providers may be added, if required. For further information about external authentication and single sign-on, see chapter—Configuring External Authentication in the Hyperion Enterprise Administrator's Guide.

The Hyperion Enterprise installation program installs the following products, based on the options that you select:

Hyperion Enterprise Release 6.5.1.1.000
- External Security Services
- Hyperion Statutory Consolidation Engine
- Hyperion Enterprise Application Server
- Hyperion Enterprise Data Server
For information about the enhancements and considerations for this release of Hyperion Enterprise, see the Hyperion Enterprise Release 6.5.1.1.000 Readme document.

Note: If you have Hyperion Enterprise release 6.4.0.0.000 or earlier installed on your system, you should uninstall the previous versions as outlined in Chapter 7, “Uninstalling Hyperion Enterprise.” Hyperion Enterprise release 6.5.1.1.000 supports upgrade installation of release 6.4.1.0.000 or higher.
System Requirements

This section provides configuration requirements and recommendations for the Hyperion Enterprise Release 6.5.1.1.000 client workstation, Web server, file server, database, application server, and message server. The following specifications cover Hyperion Enterprise Release 6.5.1.1.000 software and related applications only. Your particular installation might need additional memory, space, and processing capabilities, depending on the requirements of your operating system and any other software you might be running.

Windows Client Workstation Requirements

Table 1 lists configuration requirements and recommendations for a Hyperion Enterprise Release 6.5.1.1.000 client workstation. The size and complexity of your applications may impact the workstation requirements.

<table>
<thead>
<tr>
<th>Component</th>
<th>Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
<td>● Minimum - Pentium 200</td>
</tr>
<tr>
<td></td>
<td>● Recommended - Pentium 500 or faster</td>
</tr>
<tr>
<td>Memory</td>
<td>● Minimum - 512 MB</td>
</tr>
<tr>
<td></td>
<td>● Recommended - 1 GB or greater, particularly for system administration</td>
</tr>
<tr>
<td>Disk space</td>
<td>● 10 MB if system files and application data reside on a file server (recommended)</td>
</tr>
<tr>
<td></td>
<td>● 75 MB, plus space for application data as needed, if system and data files reside locally</td>
</tr>
<tr>
<td>Component</td>
<td>Requirements</td>
</tr>
<tr>
<td>----------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Operating systems</td>
<td>Operating System for Both 32-bit and 64-bit.</td>
</tr>
<tr>
<td></td>
<td>- Windows XP Professional (with Service Pack 3)</td>
</tr>
<tr>
<td></td>
<td>- Windows Vista</td>
</tr>
<tr>
<td></td>
<td>- Windows 7</td>
</tr>
<tr>
<td>Web browsers</td>
<td>Web browsers 32-bit:</td>
</tr>
<tr>
<td></td>
<td>- Internet Explorer 6.0, 7.0, and 8.0.</td>
</tr>
<tr>
<td></td>
<td>- FireFox 3.5.x and 3.6.x</td>
</tr>
<tr>
<td></td>
<td>Web browsers 64-bit:</td>
</tr>
<tr>
<td></td>
<td>- Internet Explorer 7.0</td>
</tr>
<tr>
<td></td>
<td>- Internet Explorer 8.0</td>
</tr>
<tr>
<td>RAM (client) and swap file</td>
<td>- RAM - 512 MB minimum</td>
</tr>
<tr>
<td></td>
<td>- Swap file–Up to 2.5 times the size of physical memory if required.</td>
</tr>
<tr>
<td>Note:</td>
<td>Refer to the Microsoft documentation for exact figures and additional information.</td>
</tr>
<tr>
<td>Spreadsheet add-ins</td>
<td>Microsoft Excel XP, 2003, 2007, or 2010</td>
</tr>
<tr>
<td>Note:</td>
<td>All spreadsheet add-ins are only supported in 32-bit.</td>
</tr>
<tr>
<td>Monitors and other</td>
<td>- Minimum - SVGA 1024 x 768 resolution</td>
</tr>
<tr>
<td>peripherals</td>
<td>Color Settings</td>
</tr>
<tr>
<td></td>
<td>16 bit (High Color), or preferably 24 bit (True Color)</td>
</tr>
<tr>
<td>Network connection</td>
<td>- Hyperion Enterprise Release 6.5.1.1.000 File-Based: Use whatever protocol is necessary to support your network file server. We recommend using a single protocol.</td>
</tr>
<tr>
<td>Database connectivity</td>
<td>- Hyperion Enterprise Release 6.5.1.1.000 File-Based: Not applicable</td>
</tr>
<tr>
<td>Paging file size</td>
<td>Configure for the client operating system as recommended by Microsoft Corporation.</td>
</tr>
<tr>
<td>Database</td>
<td>- Oracle 10.2.0.3.</td>
</tr>
<tr>
<td></td>
<td>- Oracle 11g (Fusion)</td>
</tr>
<tr>
<td></td>
<td>- SQL Server 2005 and 2008</td>
</tr>
<tr>
<td></td>
<td>These database are used only to record event logs.</td>
</tr>
<tr>
<td>Essbase</td>
<td>- E*S 7.1.x to System 9</td>
</tr>
<tr>
<td></td>
<td>- Runtime Client 7.1.x to System 9</td>
</tr>
</tbody>
</table>

The disk space requirement for a complete installation assumes that you install the components selected by default by the setup program. Changing the default selections changes the amount of disk space required. For more information on the default setup selections, see “Performing a Complete Installation” on page 33.

The disk space requirement for a workstation installation reflects the total size of Windows system files that are copied to your system.
**File Server Requirements (Without Data Server)**

Table 2 lists configuration requirements and recommendations for a Hyperion Enterprise Release 6.5.1.1.000 file server.

<table>
<thead>
<tr>
<th>Component</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
<td>Pentium II - IV (500 MHz or faster)</td>
</tr>
<tr>
<td>Memory</td>
<td>● Minimum - 512 MB</td>
</tr>
<tr>
<td></td>
<td>● Recommended - 1 GB or more</td>
</tr>
<tr>
<td>Novell Netware</td>
<td>Version 4.12, 5.x, or later</td>
</tr>
<tr>
<td>Disk space</td>
<td>● Minimum - 100 MB</td>
</tr>
<tr>
<td></td>
<td>● Typical range: 100 to 500 MB, depending on the size of the applications,</td>
</tr>
<tr>
<td></td>
<td>including system files</td>
</tr>
<tr>
<td></td>
<td>● System files: 75 MB, including all add-on modules</td>
</tr>
<tr>
<td>Operating systems</td>
<td>Server Operating System 32-bit</td>
</tr>
<tr>
<td></td>
<td>● Windows 2003 R2 Server Service Pack 2</td>
</tr>
<tr>
<td></td>
<td>● Windows 2008 Server Service Pack 1</td>
</tr>
<tr>
<td></td>
<td>● Must provide file service support to the client workstation.</td>
</tr>
<tr>
<td></td>
<td>Server Operating System 64-bit (x64 based Only)</td>
</tr>
<tr>
<td></td>
<td>● Windows 2003 Server Service Pack 2 x64</td>
</tr>
<tr>
<td></td>
<td>● Windows 2008 Server Service Pack 1 x64</td>
</tr>
<tr>
<td></td>
<td>● Windows 2008 R2 Server</td>
</tr>
<tr>
<td>Dedicated file server</td>
<td>Not required.</td>
</tr>
<tr>
<td>Network communications software</td>
<td>Windows 2003 Server (with Service Pack 2)</td>
</tr>
<tr>
<td></td>
<td>● Windows 2008 Server (with Service Pack 1)</td>
</tr>
<tr>
<td>Wide area networks</td>
<td>Hyperion Enterprise Release 6.5.1.1.000 is best used in a distributed</td>
</tr>
<tr>
<td></td>
<td>environment, and thus large wide area network (WAN) performance decreases.</td>
</tr>
<tr>
<td></td>
<td>To improve performance, use Citrix Presentation server, Hyperion</td>
</tr>
<tr>
<td></td>
<td>Enterprise Web Server, or Hyperion Enterprise® Reporting - Web Server,</td>
</tr>
<tr>
<td></td>
<td>which are designed to allow remote access to Hyperion Enterprise Release</td>
</tr>
<tr>
<td></td>
<td>6.5.1.1.000 data.</td>
</tr>
</tbody>
</table>

**File Server Requirements (With Data Server)**

Table 3 lists configuration requirements and recommendations for a Hyperion Enterprise Release 6.5.1.1.000 file server that utilizes Hyperion Enterprise Data Server:
Table 3  File Server Requirements (with Data Server)

<table>
<thead>
<tr>
<th>Component</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
<td>Pentium II - IV (500 MHz or faster, depending on number of users and size of application)</td>
</tr>
<tr>
<td>Memory</td>
<td>1 GB minimum (depending on the size of the application)</td>
</tr>
<tr>
<td>Operating system</td>
<td>Server Operating System 32-bit</td>
</tr>
<tr>
<td></td>
<td>- Windows 2003 R2 Server Service Pack 2</td>
</tr>
<tr>
<td></td>
<td>- Windows 2008 Server Service Pack 1</td>
</tr>
<tr>
<td></td>
<td>- Must provide file service support to the client workstation.</td>
</tr>
<tr>
<td></td>
<td>Server Operating System 64-bit (x64 based Only)</td>
</tr>
<tr>
<td></td>
<td>- Windows 2003 Server Service Pack 2 x64</td>
</tr>
<tr>
<td></td>
<td>- Windows 2008 Server Service Pack 1 x64</td>
</tr>
<tr>
<td></td>
<td>- Windows 2008 R2 Server</td>
</tr>
<tr>
<td>File server</td>
<td>Recommended:</td>
</tr>
<tr>
<td></td>
<td>- A dedicated file server for the Application Server</td>
</tr>
<tr>
<td></td>
<td>- A dedicated file server for the Hyperion Enterprise Application and Data Servers</td>
</tr>
<tr>
<td>Network communication software</td>
<td>- Windows 2003 Server (with Service Pack 2)</td>
</tr>
<tr>
<td></td>
<td>- Windows 2008 Server (with Service Pack 1)</td>
</tr>
<tr>
<td>Swap file</td>
<td>Up to 2.5 times the size of the physical memory. Follow Microsoft recommendations if physical memory resources become an issue.</td>
</tr>
</tbody>
</table>

**Hyperion Enterprise Web Client**

There are no special operating system requirements for the Web client. Hyperion Enterprise users can load data, perform consolidations, and work on journals through a Web-based user interface. You can use Web browsers (32-bit) such as: Microsoft Internet Explorer 6.0, 7.0 and 8.0 or Firefox 3.5.x and 3.6.x.

We also support 64-bit Web browsers such as: Microsoft Internet Explorer 7.0 and 8.0.

Table 4  Web Server Requirements

<table>
<thead>
<tr>
<th>Component</th>
<th>Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Virtual Machine and User Interface Design Framework</td>
<td>- Java 1.6.20 or higher is required</td>
</tr>
</tbody>
</table>

**Hyperion Enterprise Web Server**

The Hyperion Enterprise administrator builds and maintains the application on a x86 server. Table 5 shows the requirements for Hyperion Enterprise Web Server.
Table 5  Windows 32-bit based Server Requirements

<table>
<thead>
<tr>
<th>Component</th>
<th>Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microprocessor</td>
<td>Pentium III or later</td>
</tr>
<tr>
<td>Memory</td>
<td>1 GB minimum (depending on the size of the application)</td>
</tr>
<tr>
<td>Disk space</td>
<td>500 MB minimum</td>
</tr>
<tr>
<td>Operating system</td>
<td>• Windows 2003 Server (with Service Pack 2) with IIS 6.0</td>
</tr>
<tr>
<td></td>
<td>• Windows 2008 Server with IIS 7.0.</td>
</tr>
<tr>
<td>Other</td>
<td>• Java 1.6.20 (32-bit only) or higher is required plug-in</td>
</tr>
</tbody>
</table>

Table 6  Web Server Requirements

<table>
<thead>
<tr>
<th>Component</th>
<th>Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microprocessor</td>
<td>Pentium III or later</td>
</tr>
<tr>
<td>Memory</td>
<td>1 GB minimum (depending on the size of the application)</td>
</tr>
<tr>
<td>Disk space</td>
<td>500 MB minimum</td>
</tr>
<tr>
<td>Operating system</td>
<td>• Windows 2003 Server (with Service Pack 2) with IIS 6.0</td>
</tr>
<tr>
<td></td>
<td>• Windows 2008 Server with IIS 7.0.</td>
</tr>
<tr>
<td>Other</td>
<td>• Java 1.6.20 (32-bit only)</td>
</tr>
</tbody>
</table>

Application Server Requirements for Hyperion Enterprise

These are the requirements for setting up your application server for server processing. For more information on installing Windows 2003 Server and installing and managing TCP/IP services, refer to the Microsoft Windows 2003 Server Installation Guide.

Table 7 shows the Hyperion Enterprise application server requirements. Your paging file size setting should be the Microsoft Corporation recommendation for your operating system.

Table 7  Application Server Requirements

<table>
<thead>
<tr>
<th>Component</th>
<th>Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
<td>Minimum - Pentium at 500 MHz (Multiple processors recommended.)</td>
</tr>
<tr>
<td>Memory</td>
<td>• 512 MB minimum</td>
</tr>
<tr>
<td></td>
<td>• 1 GB or more recommended</td>
</tr>
<tr>
<td>Disk space</td>
<td>500 MB minimum</td>
</tr>
</tbody>
</table>
Message Server Requirements for Hyperion Enterprise

These are the requirements for setting up your message server for server processing. For more information on installing Windows 2003 Server and installing and managing TCP/IP services, refer to the Microsoft Windows 2003 Server Installation Guide.


Table 8 shows the Hyperion Enterprise Window 32-bit message server requirements. Your paging file size setting should be the Microsoft Corporation recommendation for your operating system.

Table 8 Window 32-bit Message Server Requirements

<table>
<thead>
<tr>
<th>Component</th>
<th>Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
<td>Minimum - Pentium at 500 MHz (Multiple processors recommended,)</td>
</tr>
<tr>
<td>Memory</td>
<td>• 512 MB minimum</td>
</tr>
<tr>
<td></td>
<td>• 1 GB or more recommended</td>
</tr>
<tr>
<td>Disk space</td>
<td>500 MB minimum</td>
</tr>
<tr>
<td>Operating system</td>
<td>• Windows 2003 Server (with Service Pack 2)</td>
</tr>
<tr>
<td></td>
<td>• Windows 2008 Server</td>
</tr>
<tr>
<td></td>
<td>• Installed TCP/IP</td>
</tr>
</tbody>
</table>

Table 9 shows the Hyperion Enterprise Web based message server requirements.

Table 9 Web-based Message Server Requirements.

<table>
<thead>
<tr>
<th>Component</th>
<th>Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
<td>Minimum - Pentium at 500 MHz (Multiple processors recommended,)</td>
</tr>
</tbody>
</table>
Component Requirements

<table>
<thead>
<tr>
<th>Component</th>
<th>Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory</td>
<td>• 512 MB minimum</td>
</tr>
<tr>
<td></td>
<td>• 1 GB or more recommended</td>
</tr>
<tr>
<td>Disk space</td>
<td>500 MB minimum</td>
</tr>
<tr>
<td>Operating system</td>
<td>• Windows 2003 Server (with Service Pack 2) with IIS 6.0 installed. Any version of IIS above 6.0 will not install on the Windows 2003 Server operating system.</td>
</tr>
<tr>
<td></td>
<td>• Windows 2008 Server (with Service Pack 1) with IIS 7.0 installed.</td>
</tr>
</tbody>
</table>

Hyperion Enterprise Smart View Provider Requirements

The following table lists the system requirements for installing Hyperion Enterprise Oracle Hyperion Smart View for Office, Fusion Edition Provider.

Table 10  System Requirements for Hyperion Enterprise Smart View Provider

<table>
<thead>
<tr>
<th>Component</th>
<th>Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microprocessor</td>
<td>Pentium III or later</td>
</tr>
<tr>
<td>Memory</td>
<td>• 256 MB minimum</td>
</tr>
<tr>
<td></td>
<td>• 512 MB or more recommended</td>
</tr>
<tr>
<td>Disk Space</td>
<td>500 MB minimum</td>
</tr>
<tr>
<td>Operating System</td>
<td>• Windows 2003 Server (with Service Pack 2) with IIS 6.0</td>
</tr>
<tr>
<td></td>
<td>• Windows 2008 Server with IIS 7.0</td>
</tr>
<tr>
<td>Other</td>
<td>• ASP.NET 2.0</td>
</tr>
</tbody>
</table>

Prerequisites

Complete the following tasks before you install Hyperion Enterprise Release 6.5.1.1.000:

1. Carefully review the Hyperion Enterprise Release 6.5.1.1.000 Readme document.
2. Close all Windows programs.
3. If you are upgrading from an earlier release, complete the following tasks using the earlier release:
   • Back up existing Hyperion Enterprise applications.
   • Extract the applications that you want to run on release 6.5.1.1.000 from your existing release of Hyperion Enterprise.
   • If you use a customized load.per file, save a copy in another directory and move it back to the program directory after the installation is complete.
4. If you have Hyperion Enterprise release 6.4.1.0.000 or earlier installed on your system, you should uninstall the previous versions as outlined in Chapter 7, “Uninstalling Hyperion
Enterprise.” Hyperion Enterprise release 6.5.1.0.000 supports upgrade installation of release 6.4.1.0.000 or higher.

**Note:** If you have Hyperion Enterprise release 6.4.1.0.000 or higher installed on your system, you can skip step 5.

5. Uninstall Hyperion Enterprise Application Server and Hyperion Enterprise Data Server, if they are installed:
   a. To uninstall Hyperion Enterprise Application Server and Hyperion Application Data Server, select **Start > Settings > Control Panel**.
   b. Double-click **Add or Remove Program**.
   c. Select **Hyperion Enterprise** and click **Change/Remove**.
   The Setup Type dialog box is displayed.
   d. Select **Modify the Installation and click Next**.
   The Select Component dialog box is displayed.
   e. Select **Hyperion Enterprise Application Server** and **Hyperion Enterprise Data Server**.
   f. Click **Next** to uninstall.

6. If you use Novell Client 32, set File Cache Level to 0 (zero).

7. If you use a 100 MB Ethernet connection, hard code the speed and duplex settings; do not use the autonegotiate option. However, if you are using Citrix or Terminal Servers, then disable autonegotiate on the Citrix and Terminal servers.

8. Make sure that you have Modify access to the following directories:
   - Your Windows system directory; for example, `c:\windows\system`
   - Your temporary directory; for example, `c:\temp`
   - Your Hyperion Solutions applications directory; for example, `c:\program files\Hyperion Solutions`
   - Your Hypent Home directory; for example `c:\hypent_home`

9. If you are installing in a Windows 2003 or Windows 2008 environment, make sure that you have administrator rights.

10. If you have Hyperion Enterprise Reporting installed, refer to the **Hyperion Enterprise Reporting Installation Guide** for compatibility requirements and make sure that your path includes the Hyperion Enterprise Reporting directory.

11. If you are installing Hyperion Enterprise for the first time or converting from Hyperion Enterprise SE Release 1.8.2, convert your reports and books. To obtain the Hyperion Enterprise Release 1.8.2 Report Conversion Utility, contact your local Client Support office. This utility is not included in the installation media for this release.

12. If you are installing the Hyperion Enterprise Web Server, verify that you have Microsoft IIS and the required Java plug-in installed. For more information, see “Hyperion Enterprise Web Server” on page 23.
13. Make sure that all users accessing the same application map to the same drive and path or use UNC notation.

14. Be aware of the functional changes between releases of Hyperion Enterprise. For more information, see the Hyperion Enterprise Readme document.

**Additional Prerequisites**

The following topics describe prerequisites for installing Statutory Consolidation Engine, Setting up Hyperion Enterprise Servers, Setting up Security Rights, Setting up Hyperion Enterprise Web Servers, Installing and configuring Microsoft IIS, Hyperion Enterprise Application Server, Hyperion Enterprise Smart View Provider, and listing the Components and their directories.

**Hyperion Enterprise Application Server**

If Hyperion Enterprise Application Server is installed on the computer that is selected for update and Windows 2008 is also installed, then follow these steps prior to installing Hyperion Enterprise:

Create a Registry Key named Sources of type REG_MULTI_SZ, under the registry entry: 
```
HEKEY_LOCAL_MACHINE\System\CurrentControlSet\Services\EventLog\Application
```

**Using Hyperion Enterprise Application Server on Windows 2008 32 or 64-bit**

- To change the Windows registry prior to installing Enterprise on Windows 2008 32 or 64-bit, perform the following steps:

1. From the Start Menu, run Regedit.
2. Find the registry key: `HKEY_LOCAL_MACHINE\System\CurrentControlSet\Services\EventLog\Application`
3. Right click on Application.
4. Select New > Multi-String Value.
5. Name the string “Sources”.
6. Confirm the Type value is REG_MULTI_SZ.
7. Close the registry and reboot.

**Statutory Consolidation Engine**

You must have Modify rights to all Statutory Consolidation Engine (SCE) directories.
Hyperion Enterprise Servers

Before installing and using Hyperion Enterprise Application Server, Hyperion Enterprise Data Server, Hyperion Enterprise Web Server, and Hyperion Enterprise Message Server you must verify TCP/IP connectivity and set up security rights.

Verifying TCP/IP Connectivity

To verify TCP/IP connectivity:

1. Make sure that both the server and the client workstations have TCP/IP installed and that each computer is uniquely identifiable by way of a TCP/IP address.

2. If dynamic resolution is not supported, make sure that the IP address of the server is resolved in the hosts file located in the system32\drivers\etc\ subdirectory for Windows 2003.

3. Verify connectivity between the client workstation and server:
   a. From a Command Prompt line on the client workstation, type the following command: `ping servername`.
   b. Press Enter.

   A reply from the server indicates that connectivity has been validated.

Setting Up Security Rights

Before you install and set up the Hyperion Enterprise Data Server, you must ensure that the Windows 2003, or Windows 2008 user ID that is used to install and start the service has the proper Windows 2003 or Window 2008 administrator permissions.

Rights to take these actions are required:

- Log on as a service.
- Log on locally.
- Act as part of the operating system.

For more detailed information on Windows 2003, or Windows 2008 administrator permissions, refer to the Windows 2003, or Windows 2008 documentation.

The Web Virtual Directory, Session Manager, and Task Server all require a system (Windows 2003 or 2008) user ID and password; the same user ID should be used for all three. The user must have read/write access to the file server (where the Hyperion Enterprise applications and executables are located), the Web Server directory, and the file upload location on the task server.

In addition to the required Windows 2003 or Windows 2008 administrator permissions, the user must have administrator permissions to access the network and administrator access to the Hyperion Enterprise application.

To set up Windows 2003 or Windows 2008 security rights:

1. From the Windows Start menu:

2 Select Local Policies > User Rights Assignment.
3 Click Log on as a service.
4 Click Add to assign this right to a user ID or group.
5 Select the user ID or group, click Add, then click OK.
6 Click Act as part of the operating system and repeat steps 4 and 5.
7 Click Log on locally and repeat steps 5 and 6.
8 Click OK and exit the program.
9 Reboot the computer.

Hyperion Enterprise Web Server

If you are installing the Hyperion Enterprise Web Server for Web-based consolidations, data loads, and journals access with Hyperion Enterprise Release 6.5.1.0.000, you must install Microsoft IIS on the Hyperion Enterprise Web Server computer first. Please note that the application metadata must be loaded before you can use the Web Service.

For instructions, see Chapter 4, “Installing Hyperion Enterprise.”

Installing and Configuring Microsoft IIS

Installing IIS on Windows 2008 64-bit Operating System

If you plan to use Hyperion Enterprise Web, then follow these steps prior to installing Hyperion Enterprise:

1 Install IIS7.0, including the Application Development options:
   - Select Start > Administrative Tools > Server Manager > Roles.
   - Right-click on Roles and select Add Roles.
   - Select Web Server (IIS) and click Next.
   - An introduction to the Web Server page is displayed. Click Next to continue.
   - Select Application Development, IIS 6 Management Compatibility options and Management Service in the role services panel to install IIS and click Next.
   - Confirm installation selections for Web server (IIS) and click Install.

2 After installation, run the following command from the either the command or Windows Run prompt verbatim (you may copy this command into notepad and then paste the same into the Command or Run prompt):
Perform Hyperion Enterprise complete installation on Windows 2008 64-bit operating system.

If Hyperion Enterprise Web is already installed on the computer that is selected for update, then follow these steps:

1. Disable all Data Server enabled applications and then shutdown all processes.
2. Uninstall Hyperion Enterprise and reboot.
3. Uninstall IIS7.0 and reboot.
4. Install IIS7.0, “see the Installing IIS on Windows 2008 64 bit Operating System”
5. After installation, run the following command from the either the command or Windows run prompt verbatim (you may copy this command into notepad and then paste the same into the Command or Run prompt):

   \%windir\%\system32\inetsrv\appcmd set config -
   section:applicationPools -
   applicationPoolDefaults.enable32BitAppOnWin64:true

6. Perform Hyperion Enterprise complete installation on Windows 2008 64-bit operating system.

For information on installing and configuring Microsoft IIS, see Appendix A, “Manual Configuration of Web Environment.”

**Prerequisites for Installing Hyperion Enterprise Release 6.5.1.1.000 on Windows 2003 64-bit Operating System**

Prerequisites: Ensure IIS 6 64-bit is installed.

**Note:** If Hyperion Enterprise is not installed on the computer. Please follow these steps prior to installing Hyperion Enterprise.

To install Hyperion Enterprise Release 6.5.1.1.000 on Windows Server 2003 64-bit Operating System.

1. Run the following command from a command prompt:

   cscript \%SYSTEMDRIVE\%\inetpub\adminscripts\adsutil.vbs SET W3SVC/AppPools/Enable32bitAppOnWin64 1

2. Download both the 32 bit and 64 bit installs for JRE from the website www.java.com.
3. Install the 32 bit version of JRE (this must be installed first).
4. Install the 64 bit version of JRE (this must be installed after installing the 32 bit version).
5. Ensure that the 32 bit version of ASP.NET version 2.0.50727 is set to Allowed in the Web Service Extensions list in Internet Information Services Manager.
6 Install Hyperion Enterprise 6.5.1.1.000 and Hyperion Enterprise Reporting 6.5.1.1.000.

**Note:** If Hyperion Enterprise is already installed on the computer that is selected for update, then follow these steps.

1. **To upgrade the Hyperion Enterprise Release 6.5.1.1.000 on Windows 2003 Server 64-bit environment**
   1. Uninstall both Hyperion Enterprise and Hyperion Enterprise Reporting.
   2. Select **Start > Control Panel > System** and then select the **Environment Variables** button on the **Advanced** tab.
   3. Remove references to Hyperion Enterprise in the **Path**.
   4. Reboot the system.
   5. Run the following command from a command prompt:
      ```
      cscript %SYSTEMDRIVE%\inetpub\adminscripts\adsutil.vbs SET W3SVC/AppPools/Enable32bitAppOnWin64 1
      ```
   6. Download both the 32 bit and 64 bit installs for JRE from the website www.java.com.
   7. Install the 32 bit version of JRE (this must be installed first).
   8. Install the 64 bit version of JRE (this must be installed after installing the 32 bit version).
   9. Ensure that the 32 bit version of ASP.NET version 2.0.50727 is set to Allowed in the Web Service Extensions list in Internet Information Services Manager.
   10. Install Hyperion Enterprise Release 6.5.1.1.000 and Hyperion Enterprise Reporting Release 6.5.1.1.000.

**Hyperion Enterprise Smart View Provider**

You must perform these prerequisites to install Hyperion Enterprise Smart View Provider.

1. You must install Hyperion Enterprise Release 6.5.1.1.000 with the Hyperion Enterprise Web component before installing Hyperion Enterprise Smart View provider to work with Smart View.
2. You must have a valid license agreement to run Oracle Hyperion Smart View for Office, Fusion Edition.

**Components and Their Directories**

When you run the setup program, you can install Hyperion Enterprise Release 6.5.1.1.000 either in the default directory suggested by the setup program or you can specify other directory.

**Note:** The string “HE” cannot be used as a directory name when installing Hyperion Enterprise.
Table 11 shows location where components are installed:

Table 11  Location of Components Installed

<table>
<thead>
<tr>
<th>Components</th>
<th>Installation Locations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hyperion Enterprise Release 6.5.1.1.000</td>
<td>Drive:\program files\hyperion solutions\hyperion enterprise</td>
</tr>
<tr>
<td><strong>Note:</strong> Hyperion Retrieve is automatically installed with Hyperion Enterprise Release 6.5.1.1.000</td>
<td></td>
</tr>
<tr>
<td>Hyperion Enterprise Office Provider</td>
<td></td>
</tr>
<tr>
<td>Hyperion Statutory Consolidation Engine (SCE)</td>
<td></td>
</tr>
<tr>
<td>Hyperion Enterprise Application Server</td>
<td></td>
</tr>
<tr>
<td>Hyperion Enterprise Data Server</td>
<td></td>
</tr>
<tr>
<td>Hyperion Enterprise Message Server</td>
<td></td>
</tr>
<tr>
<td>Hyperion Enterprise Web Server</td>
<td></td>
</tr>
<tr>
<td>Hyperion Enterprise Conversion Utilities</td>
<td></td>
</tr>
<tr>
<td>Hyperion Allocations</td>
<td></td>
</tr>
<tr>
<td>Hyperion LedgerLink</td>
<td></td>
</tr>
<tr>
<td>Hyperion AutoPilot</td>
<td></td>
</tr>
<tr>
<td>Hyperion SmartView provider</td>
<td></td>
</tr>
<tr>
<td>Hyperion Enterprise Extraction Utility</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** In releases of Hyperion Enterprise earlier than Release 6.0, the default program directory was hypent. This installation does not overwrite or delete any existing hypent directory. Manually update your autoexec.bat file or environment variable to remove the old reference to the hypent directory from your path statement.

**Installation Tasks**

When installing Hyperion Enterprise, you may need to perform the following tasks:

- Check the system requirements. For more information, see “System Requirements” on page 13.
- Select one of these installation methods: Quick Install, Silent Mode Install, or a Regular install. For more information, see Chapter 3, “Quick Install and Silent Mode Installation,” or Chapter 4, “Installing Hyperion Enterprise.”
- Install add-ons for Hyperion Enterprise. For more information, see Chapter 5, “Additional Installation Procedures.”
- Convert your current application to a newer version of Hyperion Enterprise. For more information, see Chapter 6, “Converting Your Application to Hyperion Enterprise Release 6.5.1.1.000.”
- Configure Microsoft IIS to deploy Hyperion Enterprise for the Web environment. For more information, see Appendix A, “Manual Configuration of Web Environment.”
Review available documentation accompanying this release. For more information, see Appendix B, “Hyperion Enterprise Documentation.”

Review a list of program files installed in your Windows system directories during installation. For more information, see Appendix C, “Program Files Inventory.”

Review descriptions of the products and add-ons available in this release. For more information, see Appendix D, “Product Inventory.”

**Compatible Products**

If you have Hyperion Enterprise Reporting installed, refer to the Hyperion Enterprise Reporting Installation Guide for compatibility requirements.

**Port Numbers Used by Hyperion Products**

See Appendix E, “Ports”
Quick Install and Silent Mode Installation

This chapter describes the most direct way to perform a Hyperion Enterprise installation.

Installation Methods

Quick Install and Silent Mode installation use the default selections of the installation program. Use Quick Install and Silent Mode only if the following statements is true:

- You want to install only core Hyperion Enterprise and none of its components.
- You want to install all files on a local or network drive, then run Hyperion Enterprise from that drive.

If your situation does not meet these conditions or if you want to install a different set of products, see Chapter 4, “Installing Hyperion Enterprise” for instructions on installing this release.

Note: When uninstalling an earlier release of Hyperion Enterprise, you must exit Hyperion Enterprise application, Hyperion Enterprise Data Server, Hyperion Enterprise Web Server, and Hyperion Enterprise Application Server. Failure to close these programs produces a message stating that a component move data error has occurred. Oracle’s Hyperion recommends that you remove any earlier release of Hyperion Enterprise before upgrading to a new release. Hyperion Enterprise release 6.5.1.0.000 supports upgrade Installations from 6.4.0.0.000 only.

Performing a Quick Install

The Quick Install procedure does not install Hyperion Enterprise Data Server, Hyperion Enterprise Application Server, Hyperion Enterprise Message Server, Web Server, Statutory Consolidation Engine, Hyperion LedgerLink, Allocations, Hyperion AutoPilot, or the Hyperion Enterprise conversion utilities.
Before you use the Quick Install procedure, refer to Chapter 2, “Planning the Installation.”

To perform a Quick Install:

1. From the Windows Start menu, run `path\install.exe` where `path` is the path to the Hyperion Enterprise installation directory.
   - The Select Install Language screen is displayed.

2. In the Select Install Language dialog box, select a language, then click OK.
   - Note: The default language is set to English.

   The Welcome screen is displayed.

3. In the Welcome screen, click Next.
   - The Hyperion Enterprise agreement dialog box is displayed.

4. Click Yes to continue.
   - The Hyperion Enterprise Setup dialog box is displayed.

5. Select the type of setup that you want to install and click Next.
   - The Retrieve Version Selection dialog box is displayed.

6. Select the required version of Hyperion retrieve and click Next.
   - The Choose Destination dialog box is displayed.
   - Specify the directory in which to install Hyperion Enterprise:
     - To accept the default installation directory, click Next.
     - To select an installation directory other than the default, click the Browse button and navigate to that directory, then click Next.
       - The Select Component dialog box is displayed.

7. Select the components that you want to install and click Next.
   - The Select Program Folder dialog box is displayed.

8. Specify the program folder where Hyperion Enterprise program icons will be stored:
   - To accept the default program folder, click Next.
   - To store the icons in a program folder other than the default, click the directory name in the Existing Folders list and then click Next.

9. Review your current installation settings, then click Next.

10. Click Finish to close the Hyperion Enterprise installation.
**Note:** With the installation of Hyperion Enterprise you can create applications and perform tasks as outlined in the *Hyperion Enterprise Administrator’s Guide* and the *Hyperion Enterprise User’s Guide*. However, in order to work with reports you need to install Hyperion Enterprise Reporting. For more information on installing Hyperion Enterprise Reporting refer the *Hyperion Enterprise Reporting Installation Guide*.

## Silent Installation

If you want to install Hyperion Enterprise on multiple computers using the same installation options, you can record your installation settings and then run a “silent” installation from the command line. Silent installations automate the installation process so that you can install Hyperion Enterprise without specifying installation settings each time.

Before you perform a Silent Mode installation, refer to Chapter 2, “Planning the Installation.”

Silent Mode installation creates a log file, `setup.log` in the installation directory, which is where the `setup.exe` file is located. The log file contains the results of the Silent Mode installation, including any error codes.

### Performing a Silent Mode Installation

1. To perform a Silent Mode installation:
   - Copy the installation files for the language you are installing either to a local drive, a different location on the same network drive, or a different network drive.
   - From the Windows **Start** menu, click **Run**.
   - Type `path\setup.exe -r` where path points to the Hyperion Enterprise installation directory on your network drive.
     
     **Note:** Do not include spaces in the path.
   - On the Welcome screen, click **Next**.
   - On the License Agreement screen, click **Yes** to continue.
   - Select the type of setup that you want to install, then click **Next**.
   - Select the required version of Hyperion retrieve and click **Next**.
   - Specify the directory in which to install Hyperion Enterprise:
     - To accept the default installation directory, click **Next**.
     - To select an installation directory other than the default, click the **Browse** button and navigate to that directory, then click **Next**.
   - In the Select Component dialog box, select the components you want to install and click **Next**.
   - In the Select Program Folder dialog box, specify the program folder where Hyperion Enterprise program icons will be stored:
     - To accept the default program folder, click **Next**.
- To select a program folder other than the default, click the **Browse** button and navigate to that program folder, then click **Next**.

11 Review your current installation settings, then click **Next**.

12 Click **Finish** to close the Hyperion Enterprise installation.

   The installation process creates a `setup.iss` file in your Windows directory.

13 Copy the `setup.iss` file to the network directory where the Hyperion Enterprise `setup.exe` file is located.

14 To install Hyperion Enterprise on another computer using Silent Mode, run `path\setup.exe -s` where `path` points to the Hyperion Enterprise installation directory on your network drive.

   The log file for the main setup, `setup.log`, is in the directory where the main response file is located.

### Driver Count Settings

If the driver count `HPDRVCNT` in the `hypent.ini` file does not equal the number of `HPDRVn` lines, an error message might be displayed. To resolve this, you must enter the appropriate additional `HPDRVn` line in the `hypent.ini` file, as in the following examples:

- **File-based version of Hyperion Enterprise:**
  
  `HPDRV1=HEFile,HEFileUI,File-based Application`
In This Chapter

Setup Options ........................................................................................................... 33
Performing a Complete Installation ............................................................................ 33
Performing a Workstation Setup Installation ............................................................. 57
Verifying Your Path ................................................................................................... 66
Driver Count Setting ................................................................................................. 66

Setup Options

You use the setup program to install this release of Hyperion Enterprise. You can select from three setup options:

- **Complete Setup**–Installs the products that you select to a local or network drive. You then run those products from that drive.

- **Workstation Setup**–Installs a minimal number of files on a workstation. You then run the installed products from the network. Therefore, you must perform the Complete Setup option to install Hyperion Enterprise on a network drive before you can perform the Workstation Setup option.

- **Modify Selectable Installation Components**–Enables you to customize a copy of the setup program if you want to eliminate one or more product components from subsequent installations for security reasons.

This chapter describes the Complete Setup and Workstation Setup procedures. For information about the Modify Selectable Installation Components option, see “Creating a Customized Setup Program” on page 69.

Performing a Complete Installation

During a complete installation, the Hyperion products that you select are installed on a local or network drive. You can then run those products from that drive.

If you are installing Hyperion Enterprise on a computer that has a server operating system, you can select options to install the Application Server, Data Server, Web Server, and Message Server components. If you do select those options, the complete installation process includes steps for
setting up those components. The steps for beginning and finishing a complete installation are the same regardless of the computer’s operating system.

**Beginning a Complete Installation**

The beginning steps of a complete installation of Hyperion Enterprise are the same for all computers, regardless of their operating systems.

To begin performing a complete installation of the Hyperion Enterprise software:

1. Take one of these actions:
   - If you downloaded the Hyperion Enterprise software from the Oracle E-Delivery site, take one of these steps:
     - Navigate to the directory where you downloaded the installation program, then double-click `install.exe`.
     - From the Windows Start menu, select Run, type the following command in the Run dialog box, and click OK:
       ```
       Drive\directory\install.exe
       ```
       where Drive and directory are the location of the Hyperion Enterprise installer.
       The Select Install Language dialog box is displayed.
2 In the Select Install Language, select a language, then click OK.

Note: The default language is set to English.

A message is displayed to say that the setup program is being prepared:

When the setup program is ready, its Welcome screen is displayed:
3 Click Next.

The License Agreement dialog box is displayed.
4 Read the license agreement carefully and select one of the following:

- To view the previous screen, select Back.
- To continue with the installation, select Yes.
- To exit installation, select No.

If you selected Yes in the License Agreement dialog box, then the Hyperion Enterprise Setup dialog box is displayed.

5 Select Complete Setup, then click Next.

The Retrieve Version Selection dialog box opens.
6 Select a retrieve version and click Next.

**Note:** The Retrieve shortcut option dialog box is displayed only if Microsoft Excel is installed on your system.

The Choose Destination Location dialog box is displayed.
7 Click **Next** to install Hyperion Enterprise in the default folder. To select an installation directory other than the default:

a. Click the **Browse** button.

   The Choose Folder dialog box is displayed:

   b. Select the directory where you want to install Hyperion Enterprise.

   c. Click **OK** to return to the Choose Destination Location dialog box.
d. Click **Next**.

The Hyperion Enterprise Home Path dialog box is displayed.

User Account Control in Windows Vista and Windows 2008 Server improves the safety and security of your computer by preventing potentially insecure software from making changes to your computer without your explicit authority.

To support the User Account Control (UAC) feature, the `HYPENT_HOME` folder is created during installation; this folder contains the Hyperion Enterprise system INI files: `hypent.ini` and `repeng.ini`. The location of `HYPENT_HOME` can be defined during the installation routine. As a result of the new security enhancement in Windows Vista and Windows 2008 Server, these two Hyperion Enterprise system INI files are moved from the WINDOWS system folder to the `HYPENT_HOME` folder.

The `<application>.ini` file is present in the application folder.

**Note:** To use the User Access Control feature, during installation; for specifying location of system-wide files, select either the default: `<Install Drive \hypent_home>` or specify a custom location. Do not select either the Program Files folder or the Windows folder.

To install the Hyperion Enterprise Home in the default path or if you want to install the Hyperion Home other than the default selected then do these tasks:

i. Click the **Browse** button:

ii. To select a different installation path:
The Choose Folder dialog box is displayed:

iii. Select the directory where you want to install Hyperion Enterprise, or type in a
directory name. The folder will be created.

iv. Click OK

v. Click Next.

The Select Components dialog box is displayed. The Destination Folder box identifies the
installation directory that you specified:
Note: If you are installing Hyperion Enterprise on a computer with a server operating system, the list of components includes the Hyperion Enterprise Application Server, Hyperion Enterprise Data Server, Hyperion Enterprise Message Server, Hyperion Enterprise Web Server components, and Hyperion Enterprise Extraction Utility. Otherwise, the list does not include these options.

8 Specify which Hyperion Solutions products you want to install:

a. Select the check boxes for all the products and utilities that you want to install, and clear the check boxes for any products that you do not want to install.

Note: External Security Services is a utility that enables you to use the Windows domain security instead of core Hyperion Enterprise Security.

b. If the **Space Required** number is greater than the **Space Available** number, select a disk drive that has sufficient space for the installation:

i. Click the **Disk Space** button.

The Available Space dialog box is displayed:

![Available Disk Space](image)

ii. From the **Drive** drop-down list, select a disk drive where the space available equals or exceeds the space required.

iii. Click **OK** to return to the Select Components dialog box.

c. To install Hyperion Enterprise in a directory other than the one you selected earlier, which you need to do if you have selected a different disk drive:

i. Click the **Browse** button:

The Choose Folder dialog box is displayed:
ii. Select the directory where you want to install Hyperion Enterprise, or type in a directory name. The folder will be created.

iii. Click OK to return to the Select Components dialog box.

d. Click Next.

e. At the background the setup installs the MSXML6 component. The MSXML6 window dialog box is displayed:

   MSXML6 is required for Extraction Utility. Setup will now install MSXML6 on your machine

f. The Select Program Folder dialog box is displayed:
Specify the program folder for storing Hyperion Enterprise program icons:

- To accept the default program folder, click Next.

**Note:** If you selected the option for installing the Hyperion Enterprise Application Server, Hyperion Enterprise Data Server, Hyperion Enterprise Message Server, or Hyperion Enterprise Web Server component, see “Setting Up Server Components” on page 45.

- To store the icons in a program folder other than the default, Enter a name or click the directory name in the Existing Folders list and then click Next.
10 Review your installation settings and take one of the following steps:

a. If any setting is incorrect, click Back and return to the dialog box where you can change it.

b. If the settings are correct, click Next.

A message is displayed to tell you that the setup program is installing Hyperion Enterprise:

11 See one of these topics for instructions on continuing with the complete installation:

- If you did not select the option for installing the Application Server, Data Server, or Web Server component, see “Finishing a Complete Installation” on page 56.
- If you selected the option for installing External Security Services, see “Installing Common Security Services (CSS)” on page 53.

**Setting Up Server Components**

If you are installing Hyperion Enterprise on a computer with a server operating system and you selected an option for installing the Application Server, Data Server, Message Server, or Web
Server component, the complete installation process includes steps for setting up Hyperion Enterprise to access one or more of those servers.

To set up Hyperion Enterprise server components:

1. On a computer with a server operating system, follow the procedure described in "Beginning a Complete Installation" on page 34, selecting one or more of these options from the Select Components dialog box:
   - Enterprise Application Server
   - Enterprise Data Server
   - Enterprise Web Server
   - Enterprise Message Server

   The Hyperion Enterprise Server Logon Credentials dialog box opens:

   ![Hyperion Enterprise Server Logon Credentials](image)

   2. In the Name text box, enter the domain name of the server and a valid user name in this format: `computer\username`

   where `computer` is the name of the computer or domain where the Hyperion Enterprise service account resides.

   3. Enter your password in the Password text box, enter it again in the Confirm Password text box, and then click the Next button.

   The Application Server Settings dialog box is displayed:
To set up the Hyperion Enterprise Application Server component, the Hyperion Enterprise Data Server component, or both:

a. To assign a port number other than the default, change the entry in the Port Number text box.

b. If you do not want the Application server connection to start automatically, clear the Auto Start check box.

c. To change the path in either Database Path or Log File text box:
   i. Click the Browse button.

   The Choose Folder dialog box is displayed:
ii. Click the directory that you want to use.

iii. Click OK to return to the Application Server Settings dialog box.

d. Select Append Current Session or Overwrite Current Session, then click Next.

**Note:** If the HEServers.xml file is not present, then the dialog box prompting you to create this file is displayed, click Yes.

If you selected the option for installing the Hyperion Enterprise Web Server component, the Hyperion Enterprise Web Server Setup dialog box is displayed:
5 In the Physical text box, specify a physical directory. To select a physical directory other than the default:

a. Click the Browse button.

The Choose Folder dialog box is displayed:

b. Click the directory that you want to specify.
c. Click OK to return to the Hyperion Enterprise Web Server Setup dialog box and click Next.

The Enterprise Messaging Server dialog box opens:

![Enterprise Messaging Server dialog box]

In the Enterprise Message server dialog box, do the following:

- In the Enterprise Messaging Server group box, select Web messaging to support messaging feature for Windows 32 and Web-based applications, select Windows 32 Messaging to support only Windows 32 messaging.

- Under Web Messaging, in the Polling Interval setting, provide the required information in seconds. The default value for the polling interval is three seconds.

- To assign a physical directory other than the default, click Browse.

**Note:** IIS must be configured. For more information, see Appendix A, “Manual Configuration of Web Environment.” If IIS is not installed, then the Web Messaging option is disabled.

The Choose Folder dialog box opens.
a. Select the directory you want to assign.
b. Click OK to return to the Hyperion Enterprise Smart View Provider Setting dialog box.
c. In the **Anonymous User** text box, enter user’s name to access server.
d. In the **Anonymous Password** text box, enter the password.
e. Click Next to continue.

The Hyperion Enterprise Smart View Provider Setting dialog box opens.
To set up Smart View Provider:

To assign a physical directory other than the default, click **Browse**.

**Note:** You cannot change the virtual directory.

The Choose Folder dialog box opens.
a. Select the directory you want to assign.
b. Click OK to return to the Hyperion Enterprise Smart View Provider Setting dialog box.
c. In the Anonymous User text box, enter user’s name to access server.
d. In the Anonymous Password text box, enter the password.
e. Click Next to continue.

The Start Copying Files dialog box opens.

6 Review your installation settings and take one of the following steps:

a. If any setting is incorrect, click Back and return to the dialog box where you can change it.
b. If the settings are correct, click Next.

A message is displayed to tell you that the setup program is installing Hyperion Enterprise:

![Installing dialog box](image)

7 If you selected the option for installing External Security Services, see “Installing Common Security Services (CSS)” on page 53.

Note: For more information about extracting Hyperion Enterprise applications to alternate consolidation products, see the Hyperion Enterprise Extraction Utility Guide.

**Installing Common Security Services (CSS)**

If you are installing Hyperion Enterprise and you selected an option for installing the external security services, the complete installation process includes steps for installing the common security services.

To set up Hyperion Home directory:

1 Follow the procedure described in “Beginning a Complete Installation” on page 34, select External Security Services option from the Select Components dialog box, if you have not started the installer.

Note: If Hyperion Home directory is detected, then CSS is installed to that directory.
2 Select the default directory to install Hyperion Home or click Browse to specify another location.

The Select a Directory dialog box is displayed.

3 Select directory you want to use, then click Open.

4 Click Next.

The Installation Status dialog box is displayed.
On successful installation, the Summary Information dialog box is displayed.

5 Click Finish.
Finishing a Complete Installation

The steps for finishing a complete installation are the same for all computers, regardless of their operating systems or the Hyperion Enterprise components you selected when you began the installation.

To finish a complete installation:

1. Follow the procedure described in “Beginning a Complete Installation” on page 34.
2. If you selected the option for installing the Hyperion Enterprise Application Server, Data Server, Web Server, or Message Server components, follow the procedure described in “Setting Up Server Components” on page 45.
3. If you selected the option for installing external security services, follow the procedure described in “Installing Common Security Services (CSS)” on page 53.

Note: With the installation of Hyperion Enterprise you can create applications and perform tasks as outlined in the Hyperion Enterprise Administrator’s Guide and the Hyperion Enterprise User’s Guide. However, in order to work with reports you need to install Hyperion Enterprise Reporting. For more information on installing Hyperion Enterprise Reporting refer the Hyperion Enterprise Reporting Installation Guide.

After you perform the preceding steps, the setup program displays a prompt asking whether you want to restart your computer:
4 Select Yes to restart your computer or No to continue working in another application, then click Finish.

If you are running an upgrade install on the computer that has the prior release of the application server components, then the upgrade installation program will automatically upgrade the application server components to this release.

Performing a Workstation Setup Installation

During a workstation installation, the setup program installs certain program files locally on a workstation so that the workstation user can access Hyperion Enterprise programs that are installed on the network. Review the following considerations before you begin a workstation installation:

- A Complete Setup installation must have been performed on a network server before you can perform a workstation installation.
- No users should be logged on to the system when you perform a Workstation installation.

To perform a workstation installation of Hyperion Enterprise:

1 Take one of these actions:
   - If you downloaded the Hyperion Enterprise software from the Oracle E-Delivery site, complete one of these steps:
     - Navigate to the directory where you downloaded the installation program, then double-click install.exe.
     - From the Windows Start menu, select Run, type the following command in the Run dialog box, and click OK:

       Drive\directory\install.exe

       where Drive and directory are the location of the Hyperion Enterprise installation program.

       The Select Install Language dialog box is displayed.
2 In the Select Install Language dialog box, select a language, then click OK.

The setup program’s Welcome screen is displayed:
3 Click Next.

The License Agreement dialog box is displayed.

![License Agreement dialog box]

Read carefully before you install this software: If you do not have a written license agreement under which the software that accompanies these terms ("software") has been licensed, have not accepted a click-through licensing agreement when downloading this software, or are not receiving this software as a maintenance update, then by selecting the "I accept" button at the end of the terms below, you agree to the terms below. This acceptance forms an agreement between the company or other legal entity for which the software has been acquired, or you personally, if you acquired the software for yourself ("licensee") and Hyperion, as

By clicking on YES, I assent to, and agree to comply with, those terms and conditions below, including but not limited to the Warranty (Section 8), Liability (Section 9) and Governing Law (Section 12(b)).
4 Read the license agreement carefully and select one of the following:

- To view the previous screen, select Back.
- To continue with the installation, select Yes.
- To exit installation, select No.

If you selected Yes in the License Agreement dialog box, then the Hyperion Enterprise Setup dialog box is displayed.

5 Select Workstation Setup, and click Next.

**Note:** The Modify Selectable Installation Components option is used to install components that were not installed during the initial installation.

The Retrieve Version Selection dialog box opens.
6 Select a retrieve version and click Next.

**Note:** The Retrieve shortcut option dialog box is displayed only if Microsoft Excel is installed on your system.

The Choose Destination Location dialog box is displayed.
7 Using one of the following methods, specify the directory on the server that contains the subdirectories where the network’s Hyperion Enterprise program files are located, then click Next:

- Enter the directory name in the text box.
- Use the Browse button to navigate to the directory:

The Select Components dialog box is displayed. The Destination Folder box identifies the network installation directory that you specified.
8 Select the components that you want to install and the workstation drive where you want to install Hyperion Enterprise, then click Next:

a. Select the check boxes for all the products and utilities that you want to install, and clear the check boxes for any products that you do not want to install.

   Note: External Security Services is a utility that enables you to use the Windows domain security instead of the core Hyperion Enterprise Security.

b. Use the Browse button to select the workstation drive where you want to install Hyperion Enterprise.

c. If the Space Required number is greater than the Space Available number, select a disk drive that has sufficient space for the installation:

   Note: The amount of required disk space that is displayed is the amount for the complete installation. The actual disk space required for a workstation installation is less.

i. Click the Disk Space button.

   The Available Space dialog box is displayed:
ii. From the Drive drop-down list, select a disk drive where the space available equals or exceeds the space required.

iii. Click OK to return to the Select Components dialog box.

iv. Select the directory where you want to install Hyperion Enterprise, and click OK to return to the Select Components dialog box.

The Select Program Folder dialog box is displayed:

9 Specify the directory where Hyperion Enterprise program icons will be stored:

- To accept the default directory, click Next.
- To store the icons in a directory other than the default, click the directory name in the Existing Folders list and then click Next.

The Start Copying Files dialog box is displayed.
10 Review your installation settings and take one of the following steps:

- If any settings is incorrect, click Back and return to the dialog box where you can change it.
- If the settings are correct, click Next.

11 Click Next.

The setup program displays a prompt asking whether you want to restart your computer.
12 Select a restarting option, then click Finish.

If you are running an upgrade install on the computer that has the prior release of the application server components, then the upgrade installation program will automatically upgrade the application server components to this release.

13 Click Finish.

For information on configuring Hyperion Enterprise Workstation installation for external authentication, see chapter—Configuring External Authentication in the Hyperion Enterprise Administrator’s Guide.

Verifying Your Path

If you did not install all products to the same directory, the folder containing the Hyperion Enterprise program executables must be in your path. If you are running a logon script, you must update it with the main program directory that you selected during installation. For more information on file locations, see “Components and Their Directories” on page 25.

Driver Count Setting

If the driver count HPDRVCNT in the hypent.ini file does not equal the number of HPDRVn lines, an error message might be displayed. To resolve this, you must manually enter the appropriate additional HPDRVn line in the hypent.ini file. See the following examples:

- File-based version of Hyperion Enterprise:
HPDRV1=HEFile,HEFileUI,File-based Application
Setting Up Hyperion Retrieve

Hyperion Retrieve is a spreadsheet add-in that must be used with either Microsoft Excel 2003, 2007, or 2010. You must install one of these products before you can build a spreadsheet. Hyperion Retrieve is automatically installed when you install Hyperion Enterprise.

Setting Up Hyperion Retrieve for Microsoft Excel

If you use Microsoft Excel, you can create an icon that loads one or more add-ins and that can load Microsoft Excel, depending on what you enter in the command line of the icon. You can also use the Manage Add-ins feature to load a fixed set of add-ins any time that Excel is launched. Setting up Hyperion Retrieve involves the following tasks:

- Creating the HPPAPP.DAT File for Hyperion Retrieve
- Creating an icon for loading Hyperion Retrieve
- Loading the Hyperion Retrieve Add-in for Microsoft Excel

For more information on Hyperion Retrieve, see the Hyperion Retrieve chapter of the Hyperion Enterprise User’s Guide.

Creating a Customized Setup Program

You can customize the Hyperion Enterprise setup program to prevent users who perform subsequent installations from installing specified components.
When you customize the setup program, you retain the original program and distribute the customized version.

To customize the Hyperion Enterprise setup program:

1. If you are installing from a network drive, copy the directory for the language you are installing to a local drive, a different location on the same network drive, or a different network drive.

2. From the language directory you copied in step 1, run the **Setup.exe** file.

   The Hyperion Enterprise Setup dialog box is displayed.

3. **Select Modify the Installation, then click Next.**

   The Select Components dialog box opens.

4. In the Modify the Installation dialog box, select the components to be included in the customized setup program and clear the check boxes for any components that you do not want to include in it, then click Next.

   ![Select Components](image)

   **Note:** Selecting the Allow Further Modification of Components option enables users of the customized setup program to make their own changes to the list of available components.

5. **Click Finish to exit the setup program.**
Installing Hyperion Enterprise Using the Customized Setup Program

After you have created a customized Setup Program, see “Creating a Customized Setup Program” on page 69. You can install Hyperion Enterprise with the components you selected while creating a customized setup program. Only the components that you selected while creating a customized setup program will be available for installation.

To install Hyperion Enterprise using the customized setup program:

1. **Browse to the language directory that you customized and click Setup.exe.**
   
   Install Hyperion Enterprise by providing information as requested by the installer.

2. **Click Finish to exit the setup program.**

Configuring Hyperion Enterprise Web Server

Hyperion Enterprise Web Server contains the following components:

- **Task Server**—Used to off-load large processes relating to the Web-based applications. Task server enables installation on multiple servers to share the tasks that are submitted through the Web.

- **Session Manager**—Tracks the following Hyperion Enterprise Web application information:
  - Users logged on
  - Tasks that are currently running
  - POVs and status.

- **Web Application**—Used to set up or enable a Hyperion Enterprise application for the Web.

Prerequisites

Before you configure Hyperion Enterprise Web Application, do the following:

1. Refer to Chapter 2, “Planning the Installation.”

2. In addition to completing the tasks outlined in the Planning the Installation chapter, do the following:
   
   a. Hyperion Enterprise has to be installed on a computer with a server operating system. For more information, see Chapter 4, “Installing Hyperion Enterprise.”

   b. The applications must be registered in Hyperion Enterprise. For more information, see the *Hyperion Enterprise Administrator’s Guide*.

   c. IIS must be configured. For more information, see Appendix A, “Manual Configuration of Web Environment.”
Configuring the Hyperion Enterprise Web Application

Configure the Hyperion Enterprise Web application to allow user access to applications in Hyperion Enterprise from multiple locations using a Web-based environment. Users with access to configured Hyperion Enterprise applications can work with consolidations, data loads, and journals on the Web.

To configure Hyperion Enterprise Web applications, do the following:

1. Open a Web browser window and enter the following information in the Address text box:
   
   http://Web Server/Virtual Directory/Default.aspx, for example:
   
   http://myserver/HEWeb/default.aspx
   
   The Logon page is displayed.

2. In the global selection frame select Tasks > Administration.
   
   The tasks you can perform in the Administration module are displayed in the local selection frame.

3. In the local selection frame select Application Setup.
   
   The Web Application Setup page is displayed.

4. Select an application to be configured for the Web from the Application drop-down list, then select Web Enabled.

5. In the User ID and Password text boxes, enter the Hyperion Enterprise administrative user ID and password.

6. You must specify the server name where the Task Server and Session Manager are installed.

7. Type Server name or IP address for Session Manager and Task Servers.

Note: You can complete the following steps for all the applications that you want to Web-enable and submit the completed information.
Specify the directory on the Web or Task server where the files should be uploaded for data loads in the 
File Upload Location text box.

Optional: If Hyperion Enterprise Reporting is installed, then type Server name or IP address for Hyperion 
Enterprise Reporting Web Server.

Type Server name or IP address for Web Application controller.

Enter the number of connections in the Number of Connections text box.

By default Hyperion Enterprise Web application supports 12 connections.

From the Select Language drop-down list, select the language you want to deploy the application with.

Click Submit.

The Web Administration Results page containing information on status of application load 
is displayed.

Click Logon to Enterprise.

For subsequent logon enter the following URL in the Web browser:

http://<Web Server>/<Virtualdirectory>/default.aspx, for example: http://
myserver/HEWeb/default.aspx

Disabling Access to Hyperion Enterprise Web Applications

Complete the following procedure in Hyperion Enterprise Web to prevent users from accessing 
specific Web applications.

➢ To disable access without restarting the Web Server:

1 Make sure all Web users are logged off from the Hyperion Enterprise Web application.

   Tip: To ensure all users are logged off, see the Active Web User List page. From the 
Application Web module, select Hyperion EnterpriseTasks>Logging to View Active 
Web Users.

2 Open a Web browser window and enter the following information in the Address text box:

   http://<Web Server>/<Virtual Directory>/Default.aspx, for example: 
http://myserver/HEWeb/default.aspx

   The Web Application Setup page is displayed.

3 In the Web Application Setup page, from the Application drop down list, select the application that you 
want to disable.

4 Deselect the Web Enabled option.

5 Enter your user name and password.

6 Click Submit.
About Hyperion Home

When multiple Hyperion products are installed on the same computer, common internal and third-party components used by the products are installed to a central location, called Hyperion Home. The Hyperion Home location is defined in the system environment variable called HYPERION_HOME.

The Hyperion Enterprise installer prompts you to define the location for Hyperion Home. The default location is C:\Hyperion. The installer searches for the HYPERION_HOME environment variable on the computer to which you are installing. If the location has been previously defined for another Hyperion product, the installation uses that location and the Hyperion Home location cannot be changed through the installer. If this is the first Hyperion installation on the computer, and you have not already specified the location for Hyperion Home, you can specify the location during installation.

Prior to installing Enterprise, you must have Modify rights to the directory HYPERION_HOME.

Changing the Hyperion Home Location

After Hyperion Home has been defined through any product installation, you must run two separate migration utilities to change the Hyperion Home location. The first utility moves the files installed in Hyperion Home to the new location, and the second utility fixes all internal references to the old Hyperion Home location. Both utilities are provided with the Hyperion Enterprise installation.

To change the Hyperion Home location:

1. **Launch the first utility by executing the following file from the current Hyperion Home location:**
   
   Windows: HYPERION_HOME/common/utilities/HyperionHomeTool/1.0.0/bin/run.exe

   The migration utility is launched.

2. **Step through the screens, and when prompted, enter the new Hyperion Home location or click Browse to navigate to the desired location.** The migration utility copies the entire Hyperion Home directory to the new location and replaces the value of the current HYPERION_HOME environment variable.
This chapter provides all the information you need to convert applications from an earlier release of Hyperion Enterprise to Hyperion Enterprise Release 6.5.1.1.000. It discusses the differences between Hyperion Enterprise Release 6.5.1.1.000 and Hyperion Enterprise SE Release 4.x, and it describes software implementation prerequisites and considerations. It also describes each conversion utility in detail. Please read through this chapter carefully before converting your application to Hyperion Enterprise Release 6.5.1.1.000.

**Feature Comparison with Hyperion Enterprise SE Release 4.x**

Hyperion Enterprise Release 6.5.1.1.000 is more flexible than Hyperion Enterprise SE when translating data to Euros or storing historical data in original input currency and Euros. Hyperion Enterprise Release 6.5.1.1.000 can handle larger applications and report in multiple currencies, and it has many other additional functions that make converting your application
and storing additional data easier. Table 12 lists major differences between Hyperion Enterprise SE and Hyperion Enterprise Release 6.5.1.000.

**Table 12  Feature Comparison with Hyperion Enterprise SE**

<table>
<thead>
<tr>
<th>Module</th>
<th>Feature</th>
<th>Hyperion Enterprise SE Release 4.4</th>
<th>Hyperion Enterprise Release 6.5.1.000</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accounts</td>
<td>Maximum number of accounts</td>
<td>16,000</td>
<td>up to 8,000,000¹</td>
</tr>
<tr>
<td>Accounts</td>
<td>Maximum account description length</td>
<td>20 per level</td>
<td>40 per level</td>
</tr>
<tr>
<td>Accounts</td>
<td>Intercompany table supported at second level</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Accounts</td>
<td>Sub-account attribute definition supported</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Accounts</td>
<td>Dynamic default intercompany table feature</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Accounts</td>
<td>Control first level sub-account table attachment only supported</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Accounts</td>
<td>Intercompany applied to a substructure</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Accounts</td>
<td>Support for shared sub-account signatures</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>AutoPilot²</td>
<td>16-bit version available</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>AutoPilot²</td>
<td>32-bit version available</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>AutoPilot²</td>
<td>Pause option available</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Categories</td>
<td>Maximum number of categories</td>
<td>32,000</td>
<td>no limit</td>
</tr>
<tr>
<td>Categories</td>
<td>Monthly rollovers supported</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Consolidation</td>
<td>Support of consolidation of entities with data only</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Consolidation</td>
<td>Statutory Consolidation Engine (SCE) included</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Consolidation</td>
<td>Can perform server-based consolidations</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Consolidation</td>
<td>Can cancel the consolidation process</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Database</td>
<td>Option to extract derived data available⁴</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Database</td>
<td>Suppress no data option during extract available⁵</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Database</td>
<td>Mathematical calculations supported during load</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Database</td>
<td>Extract DSM information supported</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Database</td>
<td>Option to lock data using server-based processing.</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Database</td>
<td>Mathematical calculations supported during extract</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Intercompany Processing</td>
<td>User-defined intercompany logic supported</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Module</td>
<td>Feature</td>
<td>Hyperion Enterprise SE Release 4.4</td>
<td>Hyperion Enterprise Release 6.5.1.1.000</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------------------------------------------------------</td>
<td>-----------------------------------</td>
<td>----------------------------------------</td>
</tr>
<tr>
<td>Intercompany Processing</td>
<td>Customized intercompany matching report available</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Journals</td>
<td>Control for future period posting behavior supported</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Journals</td>
<td>Criteria for reporting selection available</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Journals</td>
<td>Auto-numbering option available (You must select this option when setting up.)</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Journals</td>
<td>Ability to post periodic in YTD category</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Journals</td>
<td>Ability to perform server based extract and load journals</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Journals</td>
<td>Ability to access journal detail in Hyperion Retrieve</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Journals</td>
<td>Support for parent level adjustments (you must choose this option when setting up)</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Journals</td>
<td>Ability to force balancing in entity before posting</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Logic</td>
<td>Recalculation of dynamic view accounts based on view and frequency</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Logic</td>
<td>Additional logic functions</td>
<td>N/A</td>
<td>Yes</td>
</tr>
<tr>
<td>Logic</td>
<td>Compiled logic indicator by method</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Logic</td>
<td>Support for graphical logic</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Names/Entities</td>
<td>Maximum number of organizations</td>
<td>no limit</td>
<td>no limit</td>
</tr>
<tr>
<td>Names/Entities</td>
<td>Maximum number of names/entities</td>
<td>16,000</td>
<td>No limit</td>
</tr>
<tr>
<td>Names/Entities</td>
<td>Maximum number of dependents per parent</td>
<td>no limit</td>
<td>up to 8,000,000</td>
</tr>
<tr>
<td>Names/Entities</td>
<td>Maximum entity label length</td>
<td>8 characters per level</td>
<td>20 per level</td>
</tr>
<tr>
<td>Names/Entities</td>
<td>Maximum entity description length</td>
<td>8 characters per level</td>
<td>40 per level</td>
</tr>
<tr>
<td>Names/Entities</td>
<td>Ability to define organizations by period and category</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Names/Entities</td>
<td>Ability to assign translation methods by period</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Names/Entities</td>
<td>Ability to assign consolidation methods by period</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Names/Entities</td>
<td>Ability to track percent ownership, percent control, and percent consolidated</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Names/Entities</td>
<td>Storage of shared information between entities</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Names/Entities</td>
<td>Support for user-defined intercompany eliminations</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Names/Entities</td>
<td>Support for entity codes by period</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Module</td>
<td>Feature</td>
<td>Hyperion Enterprise SE Release 4.4</td>
<td>Hyperion Enterprise Release 6.5.1.1.000</td>
</tr>
<tr>
<td>-------------------------</td>
<td>----------------------------------------------</td>
<td>-----------------------------------</td>
<td>----------------------------------------</td>
</tr>
<tr>
<td>Names/Entities</td>
<td>Support for flat or staged ownership calculations</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Other</td>
<td>Desktop</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Other</td>
<td>Oracle database storage support</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Other</td>
<td>Support for server-based processes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Schedules</td>
<td>Schedules validation logic (32-bit support only)</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Security</td>
<td>Rights assignable to entities</td>
<td>Modify, View, None</td>
<td>Modify, View, None, Limited</td>
</tr>
<tr>
<td>Security</td>
<td>Rights assignable to categories</td>
<td>Modify, View, None</td>
<td>Modify, View, None, Limited</td>
</tr>
<tr>
<td>Security</td>
<td>Rights assignable to accounts and subaccounts</td>
<td>N/A</td>
<td>Modify, View, None, Limited</td>
</tr>
<tr>
<td>Security</td>
<td>Security assignable by menu option and module</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Security</td>
<td>Security assignable by user groups</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Security</td>
<td>Security assignable by element</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Security</td>
<td>Ability to view users logged on to the application</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Security</td>
<td>Ability to extract and load security definitions</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Security</td>
<td>Ability to extract user ID and password information and reload</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Security</td>
<td>Ability to lock users out of the application</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

1Hyperion recommends that the number of accounts not exceed 7.8 million. Although it is possible to have that many accounts, clients must have sufficient resources, such as a vast amount of RAM and disk space. Also, the performance of such a large application cannot be predicted accurately.

2Hyperion AutoPilot for Hyperion Enterprise SE Release 4.3 and Hyperion AutoPilot for Hyperion Enterprise Release 6.5.1.1.000 are different products.

3Consolidation stops at the last consolidated node.

4Hyperion Enterprise SE derives data for future periods when flow accounts are populated. With Hyperion Enterprise Release 6.5.1.1.000, the derived data can be included in a data extract.

5Separate control is provided to suppress accounts with no data versus accounts with real zeros. This decreases the size of the data stored and allows for more efficient consolidations. This is an optional setting.

6You can reset numbers by period.

7For applications that are very deep - for example, when several layers are attached to a single parent – performance may decrease after 140,000 entities. The average application has between 10,000 and 20,000 entities. Entity maintenance performance was improved considerably in Hyperion Enterprise Release 6.5.1.1.000, allowing a larger number of entities to be supported.

8A custom function will be available from CTS.
Compatibility of Earlier Hyperion Enterprise SE and Hyperion Enterprise 6.5.1.1.000 Releases

There are seven major features that differ between Hyperion Enterprise SE and Hyperion Enterprise Release 6.5.1.1.000:

- How intercompany eliminations are performed when substructures are used
- How the system equates accounts when writing formulas
- How the system calculates formulas
- How intercompany transactions are entered
- How acquired and disposed dates are tracked
- Universal naming convention
- System load behavior

Performing Eliminations When Substructures are Used

In Hyperion Enterprise SE, the system creates an intercompany subaccount for each subentity attached to an intercompany entity. The system eliminated this data at a level above the substructure while the value in the intercompany entity is consolidated up through the organization.

In Hyperion Enterprise Release 6.5.1.1.000, the system does not create an intercompany subaccount for subentities that are attached to intercompany entities. The reason is that intercompany subaccounts are permitted as second-level subaccounts and an additional level would require that the system handle three levels of subaccounts.

The system performs intercompany eliminations for the intercompany entity as a whole, not by sub-entity detail.

If you convert an application that uses intercompany sub-entity accounts from an earlier release of Hyperion Enterprise SE, these intercompany subaccounts are not created for the subentities. All intercompany data is retained at the intercompany entity subaccount level only. Therefore, before you convert an application that has intercompany subnames, you must complete the following tasks in the original application:

1. Create an intercompany name for each intercompany sub-name.
2. Extract the data from the original intercompany subaccounts.
3. Load the data into the new intercompany subaccounts that you just created.
4. Remove the intercompany sub-names.

Note: Before you change any settings in your original application to facilitate the conversion process, you should back up your application and its data.
Assigning Formulas to Subaccounts by Equating Major Accounts

In Hyperion Enterprise SE, you can assign the formulas created for one set of subaccounts to another set of subaccounts by equating the second major account to the first major account. For example, if you define formulas for subaccounts for ACCOUNT1 that you want to also use for the ACCOUNT2 subaccounts, you can use this formula:

#ACCOUNT2 = #ACCOUNT1

In applications built with Hyperion Enterprise SE, you can do this even if the sub-account tables attached to the major accounts are different. For this to work correctly, the signature order of these subaccounts can never change. However, when you add or delete accounts, the signature order of the chart of accounts might change, which can produce unpredictable and incorrect results.

In Hyperion Enterprise Release 6.5.1.1.000, you can define your application to use a unique signature for subaccounts that have the same ID. If you use unique sub-account signatures, assigning formulas by equating major accounts does not work. If you equate major accounts, the system displays a warning when you check formulas and does not create formulas for the destination subaccounts. However, if you use shared sub-account signatures, the system creates formulas for the destination subaccounts that have the same ID as the source subaccounts. This occurs even if the IDs of the sub-account tables attached to the two major accounts are different.

If you want to use unique signatures in a Hyperion Enterprise Release 6.5.1.1.000 application, you must write formulas for each sub-account that you want to create.

Calculating Formulas

In Hyperion Enterprise SE, the system calculates all range totaling functions (including TOT, DTO, DSU, SUB) that are defined in chart logic (called chart methods in Hyperion Enterprise) using the category-to-date values for all accounts, regardless of the data view for the category. All other formula functions calculate according to the default view of the data category.

In Hyperion Enterprise Release 6.5.1.1.000, the system calculates all formulas defined in chart methods using the data view of the category. This can produce different results than in earlier releases if the application contains periodic categories. The behavior was changed so that chart method formulas are calculated more consistently with the category data view definition.

Entering Intercompany Transactions

In Hyperion Enterprise SE, the system does not allow input into an intercompany entity’s own intercompany sub-account. In Hyperion Enterprise Release 6.5.1.1.000, you can enter data into the intercompany entity’s own intercompany sub-account. The system eliminates this balance as it would any other intercompany balance.
Tracking Acquired and Disposed Dates

In Hyperion Enterprise SE, you can specify dates for the acquisition and disposal of a name in an organization. In Hyperion Enterprise Release 6.5.1.1.000, you can select the Vary Organization by Category and Period application setting to track changes in your organization over time. If any name in your original application uses acquired and disposed dates in the organization structure, you must select the Vary Organization By Category and Period application setting when you convert the application to create the period-specific organization according to the acquired and disposed dates. For more information, see the *Hyperion Enterprise Administrator’s Guide*.

**Caution!** If you do not select the Vary Organization by Category and Period setting when the application is converted, all acquired and disposed date information is lost.

Universal Naming Convention

Hyperion Enterprise Release 6.5.1.1.000 stores file names internally in Universal Naming Convention (UNC) format so that users can select their own drive mappings. Supporting UNC paths allows an application to work seamlessly in a network environment. UNC paths allow logical connections to network devices without the need to specifically reference a network drive letter. The system can locate the network server and path with the UNC name even over a modem connection. The UNC describes network servers and share points on those servers.

UNC names start with two backslashes (\") followed by the server name. All other fields in the name are separated by a single backslash. For example, \"USER1\C:\filename.dat" refers to the filename.dat file on the C drive on the USER1 computer.

UNC is used in the Hyperion Enterprise Add Application dialog box and in Load and Extract dialog boxes such as Load and Extract Applications, Load and Extract Journals, Load and Extract Formulas, Load and Extract Security, Load and Extract Shares, and Load and Extract Data.

You can enter file locations in either UNC format or mapped drive notation. The system converts the mapped drive notation to UNC format. However, if you are creating an application on your local computer that you want other workstations to access, you must enter the UNC path, or specify a shared directory, rather than a drive-mapped path, as a path for the new application.

System Load File Behavior

You should be aware of the differences in loading data and metadata between Hyperion Enterprise SE and Hyperion Enterprise Release 6.5.1.1.000. You can see the difference by comparing Table 13 and Table 14.

Table 13 lists the system load file behavior for each table in Hyperion Enterprise SE.

<table>
<thead>
<tr>
<th>Section</th>
<th>Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>[ACCTLIST]</td>
<td>Lists append, line items in a fixed list append.</td>
</tr>
<tr>
<td>Section</td>
<td>Behavior</td>
</tr>
<tr>
<td>-------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>[ACONV]</td>
<td>Tables append, line items overwrite.</td>
</tr>
<tr>
<td>[BOOK]</td>
<td>Overwrite.</td>
</tr>
<tr>
<td>[CATEGORY]</td>
<td>Overwrite.</td>
</tr>
<tr>
<td>[CURRENCY]</td>
<td>Overwrite.</td>
</tr>
<tr>
<td>[FORMAT]</td>
<td>Overwrite.</td>
</tr>
<tr>
<td>[GROUP]</td>
<td>Groups append, accounts in a group overwrite.</td>
</tr>
<tr>
<td>[INTCACCT]</td>
<td>Overwrite.</td>
</tr>
<tr>
<td>[LOGIC]</td>
<td>Append.</td>
</tr>
<tr>
<td>[NAME]</td>
<td>Overwrite.</td>
</tr>
<tr>
<td>[NAMELIST]</td>
<td>Lists append, line items in a fixed list append.</td>
</tr>
<tr>
<td>[NCONV]</td>
<td>Tables append, line items overwrite.</td>
</tr>
<tr>
<td>[ORGANIZATION]</td>
<td>Append.</td>
</tr>
<tr>
<td>[OWNERSHIP]</td>
<td>Overwrite.</td>
</tr>
<tr>
<td>[ROLLOVER]</td>
<td>Overwrite.</td>
</tr>
<tr>
<td>[SCHEDULE]</td>
<td>Overwrite.</td>
</tr>
<tr>
<td>[SET]</td>
<td>Sets append, line items (reports) overwrite.</td>
</tr>
<tr>
<td>[SUBACCT]</td>
<td>Tables append, line items overwrite.</td>
</tr>
<tr>
<td>[SUBNAME]</td>
<td>Overwrite.</td>
</tr>
<tr>
<td>[SUBOWN]</td>
<td>Overwrite.</td>
</tr>
<tr>
<td>[SUBSTRUCTURE]</td>
<td>Append.</td>
</tr>
</tbody>
</table>

Table 14 lists the system load behavior for each table in Hyperion Enterprise Release 6.5.1.1.000.

Table 14  Hyperion Enterprise Release 6.5.1.1.000 System Load Behaviors

<table>
<thead>
<tr>
<th>Section</th>
<th>Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>[ACCTLIST]</td>
<td>Lists append, line items in a fixed list append.</td>
</tr>
<tr>
<td>[ACONV]</td>
<td>Tables append, line items overwrite.</td>
</tr>
<tr>
<td>[APPLICATION]</td>
<td>Overwrite.</td>
</tr>
<tr>
<td>[BOOKSET]</td>
<td>Sets append, line items (books) overwrite.</td>
</tr>
<tr>
<td>[CATEGORY]</td>
<td>Overwrite.</td>
</tr>
<tr>
<td>Section</td>
<td>Behavior</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------------------------------------</td>
</tr>
<tr>
<td>[CODES]</td>
<td>Overwrite.</td>
</tr>
<tr>
<td>[CONSOLASSIGN]</td>
<td>Overwrite.</td>
</tr>
<tr>
<td>[CURRENCY]</td>
<td>Overwrite.</td>
</tr>
<tr>
<td>[ECONV]</td>
<td>Tables append, line items overwrite.</td>
</tr>
<tr>
<td>[ENTITY]</td>
<td>Overwrite.</td>
</tr>
<tr>
<td>[ENTITYCODE]</td>
<td>Overwrite.</td>
</tr>
<tr>
<td>[ENTITYLIST]</td>
<td>Lists append, line items in a fixed list append.</td>
</tr>
<tr>
<td>[FORMAT]</td>
<td>Overwrite.</td>
</tr>
<tr>
<td>[FORMULAS]</td>
<td>Overwrite.</td>
</tr>
<tr>
<td>[GROUP]</td>
<td>Groups append, accounts in a group overwrite.</td>
</tr>
<tr>
<td>[ICDEPEND]</td>
<td>Overwrite.</td>
</tr>
<tr>
<td>[INTCACCT]</td>
<td>Tables append, line items overwrite.</td>
</tr>
<tr>
<td>[ORGANIZATION]</td>
<td>Overwrite.</td>
</tr>
<tr>
<td>[OWNERSHIP]</td>
<td>Overwrite.</td>
</tr>
<tr>
<td>[REPORTSET]</td>
<td>Sets append, line items (reports) overwrite.</td>
</tr>
<tr>
<td>[ROLLSET]</td>
<td>Tables append, line items overwrite.</td>
</tr>
<tr>
<td>[SCHEDULE]</td>
<td>Overwrite.</td>
</tr>
<tr>
<td>[SUBACCT]</td>
<td>Overwrite.</td>
</tr>
<tr>
<td>[SUBENTITY]</td>
<td>Overwrite.</td>
</tr>
<tr>
<td>[SUBOWN]</td>
<td>Overwrite.</td>
</tr>
<tr>
<td>[SUBSTRUCTURE]</td>
<td>Overwrite.</td>
</tr>
<tr>
<td>[SUBTABLE]</td>
<td>Appends.</td>
</tr>
</tbody>
</table>

**Requirements Comparison with Hyperion Enterprise SE**

The requirements for Hyperion Enterprise SE and Hyperion Enterprise Release 6.5.1.1.000 differ significantly.
Hyperion Enterprise SE Architecture

Hyperion Enterprise SE is available in a 16-bit and 32-bit architecture with a proprietary file-based data format. All add-ons are available in a 32-bit version of Hyperion Enterprise SE Release 4.4.

Hyperion Enterprise Release 6.5.1.1.000 Architecture

Hyperion Enterprise Release 6.5.1.1.000 is available in a 32-bit architecture with the following options:

- Hyperion Enterprise Release 6.5.1.1.000 Base–32-bit architecture, proprietary file-based data format, with or without an Application Server, Data Server, Message Server, and Web Server
- Hyperion Enterprise Release 6.5.1.1.000 Application Server–A configuration option that allows certain processes to be run on an Application Server
- Hyperion Enterprise Release 6.5.1.1.000 Data Server–A configuration option that improves performance in your file-based application
- Hyperion Enterprise Web Server–A configuration options that allows you to Web enable your file-based applications
- Hyperion Enterprise Message Server–A configuration option that allows you to send messages to Hyperion Enterprise application users

Table 15 lists the requirements for Hyperion Enterprise SE and Hyperion Enterprise Release 6.5.1.1.000.

### Table 15  Requirements

<table>
<thead>
<tr>
<th></th>
<th>Hyperion Enterprise SE</th>
<th>Hyperion Enterprise Release 6.5.1.1.000</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Client Workstation</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Processor</td>
<td>• Minimum - 486 33 MHz</td>
<td>• Minimum - Pentium 133</td>
</tr>
<tr>
<td></td>
<td>• Recommended - 486 66 MHz or faster</td>
<td>• Recommended - Pentium 200 or faster</td>
</tr>
<tr>
<td>Memory</td>
<td>• Minimum - 16 MB</td>
<td>• Minimum - 256 MB</td>
</tr>
<tr>
<td></td>
<td>• Recommended - 32 MB</td>
<td>• Recommended - 512 MB or greater, particularly for system administration</td>
</tr>
<tr>
<td>Disk space</td>
<td>• 1 MB if system files and application data reside on a file server (recommended)</td>
<td>• 10 MB if system files and application data reside on a file server (recommended)</td>
</tr>
<tr>
<td></td>
<td>• 15-35 MB, plus space for application data as needed, if system and data files reside locally</td>
<td>• 75 MB, plus space for application data as needed, if system and data files reside locally</td>
</tr>
<tr>
<td>Requirement</td>
<td>Hyperion Enterprise SE</td>
<td>Hyperion Enterprise Release 6.5.1.1.000</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>----------------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Operating system</td>
<td>● Windows 3.1x&lt;br&gt;● Windows 95</td>
<td>● Windows 2003 Server (with Service Pack 2)&lt;br&gt;● Windows XP Professional (with Service Pack 2)&lt;br&gt;● Windows 2008 Server&lt;br&gt;● Windows Vista</td>
</tr>
<tr>
<td>Monitors and other peripherals</td>
<td>● Minimum - VGA&lt;br&gt;● Recommended - SVGA 600x800</td>
<td>● Minimum - SVGA 1024 x 768 resolution</td>
</tr>
<tr>
<td>Network transport protocol</td>
<td>Any protocol that supports your network file server</td>
<td>● Hyperion Enterprise Release 6.5.1.1.000 Base: Any protocol that supports the network file server. Hyperion recommends a single protocol.&lt;br&gt;● Hyperion Enterprise Release 6.5.1.1.000 Server: TCP/IP</td>
</tr>
<tr>
<td>Database connectivity</td>
<td>Not applicable</td>
<td>● Hyperion Enterprise Release 6.5.1.1.000 Base: Not Applicable</td>
</tr>
<tr>
<td>File Server</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Dedicated</td>
<td>Not required</td>
<td>Not required</td>
</tr>
<tr>
<td>Processor</td>
<td>A processor that provides file service support to the client workstation</td>
<td>Pentium II - IV (500 MHz or faster)</td>
</tr>
<tr>
<td>Operating systems</td>
<td>A network operating system that provides file service support to the client workstation</td>
<td>● Windows 2003 Server (with Service Pack 2)&lt;br&gt;● Windows 2008 Server&lt;br&gt;● Novell Netware 4.12 and 5.x or later&lt;br&gt;● Must provide file service support to the client workstation.</td>
</tr>
<tr>
<td>Network communications software</td>
<td></td>
<td>● Windows 2003 Terminal Server&lt;br&gt;● Windows 2008 Server or Advanced Server (Service Pack 4)&lt;br&gt;● Windows 2008 Terminal Server&lt;br&gt;● Novell Netware 4.12 or 5.x or later</td>
</tr>
<tr>
<td>Memory</td>
<td>● Minimum - 32 MB&lt;br&gt;● Recommended - 64 MB</td>
<td>● Minimum - 256 MB&lt;br&gt;● Recommended - 512 MB</td>
</tr>
<tr>
<td>Disk space</td>
<td>● Typical Range: 100 MB to 500 MB, depending on the size of the applications, including system files&lt;br&gt;● System Files: 15 MB to 35 MB, depending upon add-in modules installed</td>
<td>● Minimum - 100 MB&lt;br&gt;● Recommended - 100 to 500 MB, depending on the size of the applications, including system files&lt;br&gt;● System files - 75 MB, including all add-on modules</td>
</tr>
<tr>
<td>Database</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Databases supported</td>
<td>Purpose-built</td>
<td>● Base - Purpose-built</td>
</tr>
<tr>
<td>Processor</td>
<td>A processor that provides file service support to the client workstation</td>
<td>● Base - Same processor as for file server</td>
</tr>
</tbody>
</table>
### Hyperion Enterprise SE

<table>
<thead>
<tr>
<th>Hyperion Enterprise SE</th>
<th>Hyperion Enterprise Release 6.5.1.1.000</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system</td>
<td>A network operating system that provides file service support to the client workstation</td>
</tr>
<tr>
<td></td>
<td>● Base - Same operating system as for file server</td>
</tr>
<tr>
<td>Memory</td>
<td>● 32 MB minimum</td>
</tr>
<tr>
<td></td>
<td>● 64 MB recommended</td>
</tr>
<tr>
<td></td>
<td>● Base - Same memory as for file server</td>
</tr>
<tr>
<td>Disk space</td>
<td>● Typical range: 100 MB to 500 MB, depending on the size of the applications, including system files</td>
</tr>
<tr>
<td></td>
<td>● System files: 15 MB to 35 MB, depending upon add-in modules installed</td>
</tr>
<tr>
<td></td>
<td>● 100 MB Minimum</td>
</tr>
<tr>
<td></td>
<td>● Typical range: 100 MB to 1000 MB, depending on the size of the applications, including system files. Refer to the guidelines set by your file server vendor</td>
</tr>
<tr>
<td></td>
<td>● System files: 75 MB, including all add-in modules</td>
</tr>
<tr>
<td>Network transport</td>
<td>Any protocol necessary to support your network file server</td>
</tr>
<tr>
<td>protocol</td>
<td>● Base - Whatever protocol is necessary to support your network file server</td>
</tr>
<tr>
<td>Database vendor</td>
<td>Not applicable</td>
</tr>
<tr>
<td>connectivity software</td>
<td>● Base: Not applicable</td>
</tr>
<tr>
<td>Performance tuning</td>
<td>Not applicable</td>
</tr>
<tr>
<td>requirements</td>
<td>● Base - Not applicable</td>
</tr>
<tr>
<td>Application server</td>
<td>Not applicable</td>
</tr>
<tr>
<td></td>
<td>Optional (XA Server)</td>
</tr>
<tr>
<td>Processor</td>
<td>Not applicable</td>
</tr>
<tr>
<td></td>
<td>● Pentium processor minimum</td>
</tr>
<tr>
<td></td>
<td>● 200 MHz recommended</td>
</tr>
<tr>
<td>Operating system</td>
<td>Not applicable</td>
</tr>
<tr>
<td></td>
<td>● TCP/IP</td>
</tr>
<tr>
<td>Memory</td>
<td>Not applicable</td>
</tr>
<tr>
<td></td>
<td>● 128 MB minimum</td>
</tr>
<tr>
<td></td>
<td>● 256+ MB recommended</td>
</tr>
<tr>
<td>Disk space</td>
<td>Not applicable</td>
</tr>
<tr>
<td></td>
<td>500 MB minimum(^1)</td>
</tr>
</tbody>
</table>

\(^1\)A larger amount of disk space is recommended. For optimum performance, Hyperion recommends putting your applications on multiple drives and disk controls.

### Hyperion Enterprise Conversion Utilities

Hyperion Enterprise Release 6.5.1.1.000 includes utilities that convert applications created in earlier releases for use in Hyperion Enterprise Release 6.5.1.1.000. Hyperion Enterprise Release 6.5.1.1.000 includes the following conversion utilities:

- Application Conversion SE to 6.5.1.1.000 Conversion Utility, which converts an application created in Hyperion Enterprise SE to Hyperion Enterprise Release 6.5.1.1.000.
- Application Conversion 4.7 through 6.4.0.0.000 to 6.5.1.1.000 Conversion Utility, which converts an application created in Hyperion Enterprise XA 4.7 through 6.2.2 to Hyperion Enterprise Release 6.5.1.1.000.
- System Extract from SE to 6.5.1.1.000 Conversion Utility, which converts Hyperion Enterprise SE system extracts for use in Hyperion Enterprise Release 6.5.1.1.000.
Logic Conversion from SE to 6.5.1.1.000 Conversion Utility, which converts Hyperion Enterprise SE logic files for use in Hyperion Enterprise Release 6.5.1.1.000.

**Note:** You need to rebuild Hyperion Enterprise 4.6x applications or convert them to Hyperion Enterprise XA 4.7, 5.0, 5.1, 5.5, 6.0, 6.1.1, or 6.2.2 applications and then convert the applications to Hyperion Enterprise Release 6.5.1.1.000.

## Converting Applications

**Note:** To convert an application, you first need to try to add it to the hypent.ini file. If you do not do this, you cannot reference it in the conversion utility.

### Application Conversion 4.7 Through 6.4.0.0.000 to 6.5.1.1.000 Conversion Utility

Use the Application Conversion 4.7 through 6.4.0.0.000 to 6.5.1.1.000 Conversion Utility only if you want to convert an application created in Hyperion Enterprise Release 4.7 through Release 6.4.0.0.000 to Hyperion Enterprise Release 6.5.1.1.000.

### Application Conversion from SE to 6.5.1.1.000 Conversion Utility

Deciding which conversion tool to use depends on what you want to accomplish after converting. For example, you should use one conversion tool if you want to convert your application only and not reorganize your application to make use of the new Hyperion Enterprise Release 6.5.1.1.000 features. A different conversion tool and a full or partial redesign of your old application are needed if you want to make use of some or all of the new Hyperion Enterprise Release 6.5.1.1.000 features. Use the Application Conversion from SE to 6.5.1.1.000 Conversion Utility if you want an exact replica of your Hyperion Enterprise SE application and want to convert your financial data for use in Hyperion Enterprise Release 6.5.1.1.000.

This conversion utility creates a new application that is structured exactly as it was in Hyperion Enterprise SE; therefore, you cannot use many of the new features of Hyperion Enterprise Release 6.5.1.1.000.

For example, the values in the Percent Ownership table in Hyperion Enterprise SE have the same role as the values in the Percent Consolidation table in Hyperion Enterprise Release 6.5.1.1.000. The data from the Percent Ownership table in Hyperion Enterprise SE is copied to the Percent Consolidation table in Hyperion Enterprise Release 6.5.1.1.000. The other tables in Hyperion Enterprise Release 6.5.1.1.000 that determine the consolidation method and percentage, which are the Percent Ownership and Percent Control tables, are populated with the default value of 100 percent when you use this conversion utility. If you want to replicate your Hyperion Enterprise SE application both physically and functionally, and you do not want to use any new features, you would use this conversion utility.
If you do use this conversion utility, the values of the Percent Ownership field in Hyperion Enterprise SE are transferred to the Percent Control, Percent Ownership, and Percent Consolidation fields in Hyperion Enterprise Release 6.5.1.1.000. The values are copied to all fields because of the relationship between the Percent Ownership and Percent Consolidation in Hyperion Enterprise Release 6.5.1.1.000 applications.

Hyperion Enterprise SE System Extract and Logic Conversion Utilities

Use the System Extract and Logic Conversion utilities if you plan to redesign your application to take advantage of the new Hyperion Enterprise Release 6.5.1.1.000 features and capabilities. The System Extract and Logic conversion utilities create a set of files that you can load into a new application. You must create the new application before loading the new files.

Note: If you use these utilities to create your Hyperion Enterprise Release 6.5.1.1.000 application, you need to set your application attributes. This information is not carried over from your Hyperion Enterprise SE application.

Installing the Conversion Utilities

The conversion utilities are not installed by default when you install Hyperion Enterprise Release 6.5.1.1.000. You must select the conversion utilities during the installation process.

To install the conversion utilities:

1. Complete Step 1 through Step 8 of the procedure “Performing a Complete Installation” on page 33.
2. In the Select Components dialog box, select the Enterprise Conversion Utilities option along with any other components that you want to install.
3. Finish the installation procedure by following steps 8 through 11.

Application Conversion 4.7 Through 6.4.0.0.000 to 6.5.1.1.000 Conversion Utility

You use the Application Conversion 4.7 through 6.4.0.0.000 to 6.5.1.1.000 utility to convert file-based applications from releases 4.7 through 6.4.0.0.000 to 6.5.1.1.000.

You can also convert your Statutory Consolidation Engine (SCE) Release 4.7 through Release 6.4.0.0.000 application to Release 6.5.1.1.000 using the conversion utility. The Hyperion Enterprise conversion utility does not recompile SCE. You must open the SCE Admin and compile the Default CONSOL and TRANS methods.
**Note:** After you convert an SCE application, the old file names for the SCE methods are saved in the SCE admin module and in the Hyperion Enterprise Formulas module. You can compile the old file names using the SCE admin module or the Hyperion Enterprise Formulas module.

It is especially important that you observe these requirements:

- If you are converting your application from Hyperion Enterprise XA Release 4.7, you must verify that you have sufficient memory and disk space. You need sufficient space for your backup of the application that being converted, extract files, and the new application. Hyperion recommends that you have a minimum of 1.5 times the disk space of your existing application.
- Prior to converting your SCE application, if your SCE methods are stored in a directory named ACE, you must rename this directory to SCE.

When you convert applications, you have the original application files and the converted application files. You can delete the old application files at your discretion. Hyperion recommends that you archive the original application before deleting it.

The conversion utility writes error messages to the `error.log` file for the application. You can refer to the error log for details about errors you may encounter during the conversion. Receiving an error message during conversion does not always mean that the conversion failed. You might have elements of an application that create error messages, but the conversion in its entirety has not failed. For example, deleted members may prevent fixed Account and Entity Lists from converting. In this instance, you can examine each error message in the log file, edit the application, and perform the conversion again.

If the conversion fails, you must perform the conversion again. Delete the partially converted application before performing the conversion again. Applications that have intercompany accounts attached to sub-account tables are not converted and a specific error message is displayed in the error log.

The conversion utility creates several types of extract files from the Hyperion Enterprise XA 4.7 application. Table 16 describes each extract file that is created in the converted application directory:

<table>
<thead>
<tr>
<th>File Name Extensions</th>
<th>File Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>.sce</td>
<td>SCE extract. Created only if the application uses SCE.</td>
</tr>
<tr>
<td>.all</td>
<td>Allocation extract. Created only if application includes Allocation files.</td>
</tr>
<tr>
<td>.app</td>
<td>Application extract. Always created.</td>
</tr>
<tr>
<td>.bar</td>
<td>Books and reports extract. Created only if the application contains books or reports.</td>
</tr>
<tr>
<td>.cda</td>
<td>Data extract. Always created.</td>
</tr>
</tbody>
</table>

**Note:** There is one `.cda` file created for each category in the application.
Hyperion Enterprise XA Conversion Considerations

Consider the following items when deciding to convert from Hyperion Enterprise XA:

- There is no utility available for converting your application from Hyperion Enterprise XA Release 4.5 to Hyperion Enterprise Release 6.5.1.1.000. You must rebuild your application completely, using Hyperion Enterprise Release 6.5.1.1.000.

  *Note:* You need to rebuild Hyperion Enterprise Release 4.6x applications or convert them to Hyperion Enterprise XA 4.7, 5.x, or 6.x applications and then convert the applications to Hyperion Enterprise Release 6.5.1.1.000.

- When converting from Hyperion Enterprise XA Release 4.7 to Hyperion Enterprise Release 6.5.1.1.000, consider these points:
  - Security, logic, and rules have changed significantly in Hyperion Enterprise Release 6.5.1.1.000. For more information, see the Hyperion Enterprise Administrator’s Guide and “Converting Logic Files” on page 106.
  - If your application uses the Organization by Period and Intercompany Dependents features, you should check that the values in the Ownership table contain the same values as the Intercompany Dependents table when appropriate. In earlier releases, the synchronization of Percent Control, Percent Consol, Percent Ownership, and Method, which should exist between the Ownership and Intercompany Dependents tables, was not always precise. The tables may gotten out of sync, for example: if you loaded the Intercompany Dependents section from an ASCII load file and did not load the Ownership section at the same time. Only changes made directly through the user interface were completely reliable. Although this is no longer an issue, you should complete the following activities to ensure that your tables are synchronized. If you are unclear as to whether your tables are synchronized, extract your Ownership and Intercompany Dependents tables and compare values to ensure that they match.
  - Hyperion recommends that the administrator perform the following tasks when there are no other users on the system:
    - Extract the Entity Ownership section.
    - Search the extract file for the values !-1.#R! or a negative value in the Percent Consol, Percent Owned, or Percent Control fields. If you find any of these values, you must correct it by entering the appropriate value.
    - Reload the Entity Ownership section.
    - Extract the Intercompany Dependents section.
    - Reload the Intercompany Dependents section.
    - Check the error log. If the application encountered a value that is not valid, a line number is displayed indicating the line of the extract or load file that must be corrected prior to
completing a successful load. You must enter the appropriate value or a blank if no value is desired.

**Example**

**Before:**

```
1!12!CORP    !DIV1    !   !-1.#R!-1.#R!-1.#R
```

**After:**

```
1!12!CORP    !DIV1    !   !50!50!50
```

or

```
1!12!CORP    !DIV1    !   !!!
```

- You must have an entry in your `hypent.ini` file for any Hyperion Enterprise XA Release 4.7 through Release 6.4.0.0.000 application that you want to convert. The conversion utility reads this application information to provide you with the names of XA Release 4.7 applications available for conversion.
- Status and settings such as consolidation status or locked periods within your applications are preserved when converted. Hyperion recommends that the data in all applications have a status of OK prior to conversion.
- For org-by-period applications using SCE, Hyperion strongly advises converting an application when all statuses are OK. If you convert an application with statuses other than OK, you must run a Consolidate All with Data or a Consolidate All after the conversion.

**Converting a Hyperion Enterprise Release 4.7 Through Release 6.4.0.0.000 Application to Release 6.5.1.1.000**

Before converting your Hyperion Enterprise Release 4.7 through Release 6.4.0.0.000 application to Hyperion Enterprise Release 6.5.1.1.000, you must ensure that you have sufficient disk space. Also, review the preconversion considerations in “Hyperion Enterprise XA Conversion Considerations” on page 90.

After you convert an SCE application, the old file names for the SCE methods are saved in the SCE admin module and in the Hyperion Enterprise Formulas module. You can compile the old file names using the SCE admin module or the Hyperion Enterprise Formulas module.

If you have Hyperion LedgerLink installed, the conversion utility expands the label column size for category IDs and user IDs from eight to 20 characters to make them compatible with the standard label length in Hyperion Enterprise.

If you use SCE, the Hyperion Enterprise conversion utility does not recompile SCE. You must open the SCE Admin and compile the Default CONSOL and TRANS methods.

If you want the new application to have the same name it had before the conversion, you must either delete the original application after the conversion, move the original application to a separate directory, or create the converted application in a new directory.
The application description is carried over from the original application regardless of what you enter during the conversion process. After the conversion is complete, you may edit the application description in the Hyperion Enterprise Release 6.5.1.1.000 application.

To convert a Hyperion Enterprise Release 4.7 through Release 6.4.0.0.000 application to Hyperion Enterprise Release 6.5.1.1.000:

1. From the Windows Start menu, select Programs > Hyperion Solutions > Hyperion Enterprise > Conversion Utilities > Application Conversion 4.7 through 6.4.0.0.000 to 6.5.1.1.000.

   The Convert Hyperion Enterprise 4.7 through 6.4.0.0.000 to 6.5.1.1.000 dialog box is displayed.

2. From the Application drop-down list, select the application that you want to convert to Release 6.5.1.1.000.

3. In the Userid and Password text boxes, enter your username and password.

4. In the Extract Location text box, type the path to the directory in which you want to store the Hyperion Enterprise Release 6.5.1.1.000 conversion extract files before they are loaded to your new application, or click the Browse button and navigate to the directory.

   A message is displayed to tell you when the conversion is complete.

   The conversion extract files are listed in the Table 16. You use these files to build your new application, which does not yet exist.
5 Start Hyperion Enterprise Release 6.5.1.0.000, select File > New Application, enter your user ID and password, and click Next.

The Application Setup dialog box is displayed.

![Application Setup dialog box]

6 Complete these steps and then click Next:

a. In the Application and Description text boxes, enter the application name and description, respectively.

b. Type the name of the conversion extract file, or use the Browse button to navigate to it. This is the filename with the .app extension that is located in the directory that you created in step 2.

c. Select an error log option.

The Driver Setup dialog box is displayed:
7 Enter the appropriate path information, then click Finish.

The system loads the files of your new application.

Note: The amount of time that the system takes to load your converted files depends on the number of files the application contains and the size of these files.

Application Conversion SE to Hyperion Enterprise 6.5.1.1.000 Conversion Utility

You can convert a Hyperion Enterprise SE 1.8 or Hyperion Enterprise Release 4.x application by either of the following methods:

- Use the Application Conversion from SE to Hyperion Enterprise Release 6.5.1.1.000 Conversion Utility to convert all application elements except for reports and books.

- Use the System Extract Conversion Utility to convert extracted application load files, and the Logic File conversion utility to convert logic files. For more information, see “System Extract and Logic Conversion Utilities” on page 104.

Use the Application Conversion from SE to 6.5.1.1.000 Conversion Utility if you want a replica of your Hyperion Enterprise SE application. In this case, it is extremely unlikely that the Percent Control and Percent Ownership fields will be used within the application, and it probably makes more sense to just update these fields with the application defaults. The Percent ownership field in SE populates only the Percent control field in Release 6.5.1.1.000; Percent Control and Percent Ownership default to 100 percent.
**Before You Convert**

Perform the following tasks before converting your application to Hyperion Enterprise Release 6.5.1.1.000:

- Back up the application prior to conversion.
- Ensure that you have the minimum recommended hardware requirements.
- Ensure all computers are 32-bit and have a minimum of 128 MB RAM.
- Ensure that there is sufficient disk space (at least 1.5 times the size of the existing application).
- Check for sufficient memory and swap file size (2.5 times the size of your application).
- Make note of your custom functions.
- Ensure that no names/labels that are 'reserved' in Hyperion Enterprise Release 6.5.1.1.000 are being used in the Hyperion Enterprise SE application. For example, CURR (often used by Hyperion Enterprise SE users as a label for their currency table) and Intercompany (often used as a label for a sub-account table that is used for Intercompany purposes in Hyperion Enterprise SE) are reserved names in Hyperion Enterprise Release 6.5.1.1.000. The Hyperion Enterprise Administrator’s Guide includes a list of reserved names.
- Disable screen saver programs.
- Optional: If you are acquiring business units in the future or changing their reporting structure, select the Org-by-Period option during application setup.
- Optional: If ownership of entities changes, select the Org-by-Period option during application setup.
- Optional: If you have a complex application with low data density, use SCE.
- If you do not plan to use any of the standard load.per files, you must copy your customized file from the Hyperion Enterprise SE program directory into the Hyperion Enterprise Release 6.5.1.1.000 program directory.
- Determine the options that you want to take advantage of in Hyperion Enterprise Release 6.5.1.1.000 that are not available in Hyperion Enterprise SE.
- If you are not renaming the new application, store the old application in a separate directory. You might not be able to access both of your applications if you have them in the same directory and they have the same name.
- Be aware of the many functional changes between releases, including new features, how data is stored, and how an existing feature may work differently. For more information, see “Feature Comparison with Hyperion Enterprise SE Release 4.x” on page 75. For example, be aware of how logic is executed differently in Hyperion Enterprise SE than in Hyperion Enterprise Release 6.5.1.1.000.
- Rebuild security elements and passwords as needed. The conversion utility converts only user IDs, passwords, and user groups from the security application. All groups are assigned the default security class Maximum.
- Because compiled logic files (.lgx) are not supported in Hyperion Enterprise, you must check logic in the existing application to ensure that you convert the most recent logic files before running the System Extract Conversion Utility.
In earlier releases of Hyperion Enterprise, you could compile logic statements that contained a double plus sign (++) and the double plus sign had no effect on the result of the statement; for example, #CASH++#PETTY_CASH. These statements do not compile correctly when you check formulas in Hyperion Enterprise Release 6.5.1.1.000. If double plus signs (++) are in a method, edit the file in the application before running the Conversion Utility. To do this, open each logic file, search for the double plus sign and replace with a single plus sign, and then convert.

In earlier releases of Hyperion Enterprise, you could compile logic statements that contained a plus sign (+) after a division sign (/), and the plus sign (+) had no effect on the result of the statement; for example, #INCOME/+#INCOME2. These statements do not compile correctly when you check formulas in Hyperion Enterprise Release 6.5.1.1.000. If this combination of signs is in a method, edit the file in the application before running the Conversion Utility. To do this, open each logic file, search for a plus sign after a division sign, replace with the division sign, and then convert.

In earlier releases of Hyperion Enterprise, you could compile logic statements that contained an ampersand (&) in the comment section, for example, filename & CHART logic. These statements do not compile correctly when you check formulas in Hyperion Enterprise Release 6.5.1.1.000. You must delete all ampersands within the comment section in the application before running the Conversion Utility. To do this, open each logic file, search for the ampersand in the comment section, and replace it with the word, and then convert.

The Conversion Utility builds a Hyperion Enterprise Release 6.5.1.1.000 application regardless of the existence of the Hyperion Enterprise-specific setup options selected. The converted application includes all accounts, names (which are called entities in Hyperion Enterprise Release 6.5.1.1.000), categories, logic (which is called methods in Hyperion Enterprise Release 6.5.1.1.000), data, journals, security groups, security IDs, and statuses for consolidation and methods. You then must use the Report Conversion Utility to convert all reports and books.

Periodic Consolidation is the only option selected by default on the Setup Options screen. When you convert an application using the default settings on the Setup Options screen, the consolidation and method statuses remain the same. If you select any of the following options, data is impacted in the new Hyperion Enterprise Release 6.5.1.1.000 application for all unlocked periods, and you must reconsolidate after converting the application. If you change one of the options and you do not want to consolidate prior periods, you must lock the prior periods. Any periods that you do not lock before converting must be consolidated in the new application.

- You deselect the Periodic Consolidation option to use Category-To-Date Consolidation.
- You select Translation Detail.
- You select Proportion and Elimination Detail.
- You select Use Child Rate Accounts.

If the application that you are converting has a custom Application Calendar file, then you must copy the .per file into the new Hyperion Enterprise Release 6.5.1.1.000 application directory before converting the application.
You should also consider this information before converting:

- If you plan to merge applications into a single new application you may need more disk space, memory, and so on.
- Journal information in the Journal History Report is not retained in the converted application.
- The conversion utility converts all user-defined functions created using the DEF logic function to custom functions. These custom functions are then available to all methods in the application.
- You must have Admin rights to convert an application. If you do not have Admin rights, the Conversion Utility aborts and an error message is displayed.
- When you convert reports and books, their names cannot have more than eight characters.
- If you select Shared Signatures when you convert the application and you have equated two major accounts to assign formulas to subaccounts, these formulas will not work in the converted application. For more information, see the Assigning Formulas to Subaccounts by Equating Major Accounts topic in the Setting Up Your System chapter of the Hyperion Enterprise Administrator’s Guide.

**Gathering Data to Test Your Conversion**

Here are some tests you can perform to ensure that your conversion was successful:

**Note:** Ensure all statuses are OK prior to performing any test that involves a data extract.

- Perform a data extract at the parent level before converting, then report this procedure exactly after you have converted and consolidated.
- Perform a data extract at the base level before converting, then report this procedure exactly after you have converted and consolidated.
- Run the Journal’s Canned Report on the same range of journals before and after converting and compare details. Remember there are more details included in the Hyperion Enterprise Release 6.5.1.1.000 canned reports.
- Run a report using Hyperion Retrieve (not Retrieve for Hyperion Enterprise Reporting) before and after your conversion.
- Perform a partial system extract and review the metadata in a Microsoft Access database before and after converting.

**Converting Hyperion Enterprise SE Applications to Hyperion Enterprise Release 6.5.1.1.000**

The Application Conversion from SE to 6.5.1.1.000 Conversion Utility retains all statuses in the application and converts the application automatically. If you use the System Extract and Logic
Conversion Utilities, status is not retained, and you must reconsolidate all data after creating the Hyperion Enterprise application.

**Note:** All errors encountered during the conversion process are written to the conversion log file, error.log, which is located in the Hyperion Enterprise program directory.

To convert a Hyperion Enterprise SE Application to Hyperion Enterprise Release 6.5.1.1.000:

1. From the Start menu, select Programs > Hyperion Solutions > Hyperion Enterprise > Conversion Utilities > Application Conversion SE to 6.5.1.1.000.

   The Hyperion Enterprise Conversion Wizard is displayed:

   ![Hyperion Conversion Wizard - Logon](image)

   2. Click Next.

   The Hyperion Conversion Wizard - Logon dialog box is displayed:
3 From the **Existing Standard Edition Application** drop-down list, select the application to convert, then enter your username and password in the **User ID** and **Password** text boxes and click **Next**.

The Hyperion Conversion Wizard - Hyperion Enterprise 6.5.1.1.000 Setup dialog box is displayed:
4 Select the appropriate settings for the new application.

The Hyperion Conversion Wizard - Hyperion Enterprise 6.5.1.000 Driver Setup dialog box is displayed:
5 Select the appropriate setup options, then click Next.

The Hyperion Conversion Wizard - Hyperion Enterprise 6.5.1.000 Setup Options dialog box is displayed:
Select the appropriate setup options, then click Finish.

Postconversion Tasks and Considerations

After you convert an application, you must perform the following tasks:

- If you select the DSM option when you convert the application, you must perform a Consolidate All or Consolidate All With Data to populate the DSM detail.
- If you stored translation detail in your application using sub-entities but now use the DSM, delete the sub-entities after converting your application to avoid redundant data storage.
- Check your Hyperion Enterprise error log.
- Verify that all statuses carried over correctly and all necessary locks are still active; for example, journal and data locks.
- Verify that all journals and appropriate details were converted.
- Set up security.
- Verify that IDs and passwords are still valid.
Note: Hyperion Enterprise SE IDs and passwords were not-case sensitive. For example, if you were set up with an ID of Jsmith and password of HeLLo, you could log on to Hyperion Enterprise SE successfully as jsmith with a password of hello. Hyperion Enterprise Release 6.5.1.1.000 security is case-sensitive, and it requires you to enter your ID and password exactly as created.

- Check all accounts and entity codes.
- If you are using Hyperion Reporting 2.6 or higher and want to use reports for Hyperion Enterprise Release 6.5.1.1.000, you must recompile your reports prior to using them. Reports created in earlier releases of Hyperion Reporting should be converted with the Reporting Conversion Utility.
- If you converted a Hyperion Enterprise SE application to an organization-by-period application in Hyperion Enterprise Release 6.5.1.1.000, reconsolidate after converting and run a report on the first period in the new application. Compare the results to the same report run on the final period in the Hyperion Enterprise SE application with a view of YTD. The opening balances of the first period in your new application should match your old closing balances. This report will be valid only if you have left ownership at 100 percent for entities with data for categories that existed in the old application.
- When you convert an application from Hyperion Enterprise SE, reports and books are not automatically converted. After you convert your application, copy the report and book files from your Hyperion Enterprise SE application to the Report directory of the Hyperion Enterprise Release 6.5.1.1.000 application. Recompile the report and book files in Hyperion Enterprise Release 6.5.1.1.000 before running them.

Note: If you converted from Hyperion Enterprise SE 1.8.2, you must obtain the Hyperion Enterprise 1.8.2 Report Conversion Utility by contacting Client Support prior to installing Release 6.5.1.1.000. This utility is not included in the installation media for Hyperion Enterprise Release 6.5.1.1.000. It is important that you convert your reports and books prior to installing Hyperion Enterprise Release 6.5.1.1.000.

You should also consider this information after you complete the conversion:

- Hyperion Enterprise SE has only consolidation logic. Hyperion Enterprise Release 6.5.1.1.000 divides consolidation and translation logic separately. If there is translation logic in the consolidation logic in Hyperion Enterprise SE, then all logic is placed under translation logic in Hyperion Enterprise Release 6.5.1.1.000 and needs to be divided manually.
- A DEF function in Hyperion Enterprise SE is automatically converted to a custom function in Hyperion Enterprise Release 6.5.1.1.000.
- When you convert a Hyperion Enterprise SE application that contains a dynamic view account list to Hyperion Enterprise Release 6.5.1.1.000, and you specify that the system not include Detail, the converted application contains subaccounts as well as major accounts. To avoid this, deselect first-level and second-level subaccounts, select major accounts, and refresh the list.
- If you do not select Periodic Consolidation in the Hyperion Enterprise SE application’s setup options when you convert the application, the application’s journal locks will not appear in
the converted application. To work around this, unpost then repost the journal to reapply the journal lock.

- After converting a Hyperion Enterprise SE application, the application paths in the `application.ini` file are hard-coded. To keep the paths flexible so that they are updated automatically if you move the application, manually replace the path to the Data, Inbox, Outbox, and Report directories in the `application.ini` using “@APP.” For example, change the line:

  `APP_DATA="E:\apps\Data"` to `APP_DATA="@APP\Data."`

### System Extract and Logic Conversion Utilities

Use the System Extract and Logic conversion utilities if you want to redesign your application to take advantage of the new Hyperion Enterprise Release 6.5.1.1.000 features and capabilities. This is the best method for converting your application if you redesign your existing application but still want to maintain the common elements such as information in the system file and logic. For example, if you want to make use of the ownership features with Hyperion Enterprise Release 6.5.1.1.000, you should use these conversion utilities.

### Application Load File Conversion Considerations

Before converting an application from load files, consider the following information:

- You must convert system extract and load ASCII files and all logic files individually.
- You must extract data and journals and load them manually into the converted application.
- You do not need to convert data or journals before they are loaded into the converted application. However, you can extract data and journals from only one category at a time.
- You must consolidate after you convert the application.
- When you extract data, the data file should include all journal companies and any other input entities. Depending on the application logic, some parent entities may have input accounts.
- You cannot load locked data.
- Before you load journals into the converted application, you must load the data for the entities impacted by journals. Hyperion Enterprise allows posted journals to be loaded. If you load journals first, the data does not load to the impacted entities.
- Before you can load auto-reversing journals into the converted application, you must edit the journal load file using a text editor. To do this, open the load file in any text editor, change the identifier for auto-reversing journals from R for regular journal to AR for auto-reversing journal.
- You cannot extract security from earlier releases of Hyperion Enterprise; therefore, security elements cannot be converted unless you use the conversion wizard. If you convert your application using load and extract files, you must rebuild all security elements.
Converting System Extract and Load Files

Before you convert a system extract and load file, make sure that no account and account group in the file have identical labels. For example, the file cannot have an account group with the label Income and an account with the label Income. If you convert a file with duplicate labels, Hyperion Enterprise writes an error message to the error log. If you find duplicate labels, Hyperion recommends adding characters to the end of the file name, such as _GRP to the end of the account group label or something that easily allows you to identify the new label.

- To convert a system extract or load file:

  1. From the Start menu, select Programs > Hyperion Solutions > Hyperion Enterprise > Conversion Utilities > System Extract Conversion from SE to 6.5.1.1.000.

     The Convert Hyperion Extract File dialog box is displayed:

     ![Hyperion Conversion Wizard dialog box]

     2. Enter the source and destination paths for the system file in the Source file and Destination file text boxes. You can use the Browse buttons to navigate to the files.

     3. Click Convert.

     4. Take one of these actions:

        - To convert another file, repeat steps 2 and 3.
        - To exit the utility, select Exit.

     5. To create an application that has organizations that vary by category and period, use a text editor to move the CATEGORY header and its information before the ENTITY header. For information about the format of the Ownership section for applications that have organizations that change over time, see asciifmt.xls, or call your consultant.

For more information about the Hyperion Enterprise Release 6.5.1.1.000 system file syntax, see the File Formats appendix of the Hyperion Enterprise Administrator’s Guide.
Loading Converted System Files

After converting the system files, you must load them into your new Hyperion Enterprise Release 6.5.1.1.000 application.

To load converted system files:

1. Create the new application in Hyperion Enterprise Release 6.5.1.1.000. Be sure to select the correct application calendar (.per) file. To verify which application calendar file was used to build your original application, open the Category module in the application, and highlight the first empty row. The default month that appears in Start Period is the application calendar file used to create the application. For example, if the month is January, the application calendar file is `loadjan.per`. If you used a custom `load.per` file, you must load your new application manually.

2. Perform a system load in the new application within the Application module and load the converted 1.8.1 or SE System Load (.asc) file. For more information, see “Converting System Extract and Load Files” on page 105. You should examine each error message during the application load process. For example, an error is displayed if you have a fixed account list or fixed name list that includes deleted accounts or names.

   Note: In the FORMULAS section of the load file, carefully list the methods referenced with the USE function before all other methods in your application.

3. Import each converted chart and consolidation method (.log file) into Hyperion Enterprise Release 6.5.1.1.000.

   Note: Any consolidation logic file in Hyperion Enterprise 1.8.1 that uses the PVA, VAL, or LOC translation functions should be loaded into the Hyperion Enterprise Release 6.5.1.1.000 application as a translation method and not as a consolidation method.

4. Check (recompile) each method, if required.

5. Convert reports using the Hyperion Enterprise Reporting Conversion Utility, then compile them in the converted application.

6. Import data from your Hyperion Enterprise SE or 1.8.x application.

7. Import journals from your Hyperion Enterprise SE or 1.8.x application. If your system does not convert correctly, try to analyze problem areas with your assigned Quality Engineer or Consultant.

   Note: Journal information that appears in the Journals history reporting in the original application is not retained in the new application.

Converting Logic Files

Before converting logic files, consider the following information:

- The logic file converter cannot process .log files that are larger than 64K. To convert a file larger than 64K, split the file into separate files that are less than 64K. Convert each file, then combine each into a single file after conversion.
Because this method of conversion requires a reconsolidation of all periods after loading data into the converted application, the data from the application might change after conversion if the logic or any application attribute has changed. To prevent this, after you convert the logic files and load them into the converted application, make all methods category-specific. Calculate formulas for only the historical periods in which you want data to change. Make sure only the system administrators have input rights to those categories. Lock the categories in the converted Hyperion Enterprise application.

All comments in .log files must appear to the right of the statement and must be preceded by an exclamation point if you want them to be imported into the converted Hyperion Enterprise application.

In Hyperion Enterprise, the DEF function is replaced by the custom functions feature. If the DEF function was in chart or consolidation logic in your application, it is converted to a custom function for either the chart or consolidation method. Consolidation logic from earlier releases of Hyperion Enterprise are converted into translation methods. If the DEF function uses the LOC, PVA, or VAL functions, which only work in translation methods, an error message is displayed when you recompile methods.

To correct problems recompiling methods with the DEF function:

1. Access the Hyperion Enterprise Formulas module and open any method.
2. Select Task > Custom Function.
3. In the Type area, click only Consolidation.
4. Click Translation, then save the function and exit.

To convert a logic file:

1. From the Start menu, select Programs > Hyperion Solutions > Hyperion Enterprise > Conversion Utilities > Logic Conversion from SE to 6.5.1.1.000.

The convert Hyperion Enterprise Standard Edition Logic to Hyperion Enterprise 6.5.1.1.000 Logic dialog box is displayed:
2 Enter the source and destination paths for the logic file in the Source File and Destination File text boxes. You can use the Browse buttons to navigate to the files.

3 Select one of the logic options:
   - To convert a chart logic file, select Chart Logic.
   - To convert a consolidation logic file, select Consol Logic.

   **Note:** During conversion, most consolidation logic files are converted to translation methods. That is because most files contain a translation statements, so the conversion utility assumes that they are translation methods.

4 To clear all custom functions that may have been created if you ran this utility previously, select the Clear Custom Function File check box.

   **Note:** The custom function file, customfn.log, contains a custom function for each DEF function in your logic files. Hyperion Enterprise creates this file in the same directory as the destination file. If you have not created any DEF functions in your application, this file is still created but does not contain any custom functions.

5 Click Convert.

6 Take one of these actions:
   - To convert another file, repeat steps 2 through 5.
   - To exit the utility, click Exit.

### Resetting Your Dynamic Account List Criteria

Hyperion Enterprise Release 6.5.1.1.000 contains significant changes regarding the manner in which dynamic account list criteria operate. You may have to reset your dynamic account list criteria in order to receive the same results in the converted application since this does not occur during the conversion process. New applications that are built from scratch will also exhibit this new behavior.

Hyperion Enterprise Release 6.5.1.1.000 checks the account list criteria settings for each of the three possible levels of accounts—major accounts, first level subaccounts, and second level subaccounts. In prior releases, if the criteria did not match at a higher level, Hyperion Enterprise did not check for a criteria match at the lower account levels. For more information about account lists, see the Hyperion Enterprise User’s Guide.

### Setting Your Point of View in Hyperion Enterprise

After you install Hyperion Enterprise and convert any applications, load files, logic files, reports, and books from prior releases, you should set your point of view. You cannot access the Reports and Books modules without setting a complete point of view. For instructions on setting your point of view, see the Hyperion Enterprise User’s Guide.
This chapter provides information on uninstalling Hyperion Enterprise.

Uninstalling Hyperion Enterprise

You should uninstall Hyperion Enterprise in any of these situations:

- You receive an error message during installation.
- You want to change the location of Hyperion Enterprise program files.
- You want to remove an earlier release of Hyperion Enterprise. You must remove any earlier release of Hyperion Enterprise before upgrading to Release 6.5.1.1.000. Only Release 6.4.x supports upgrade to Release 6.5.1.1.000.

**Note:** Before you uninstall or install Hyperion Enterprise, it is strongly recommended that you stop the Hyperion Enterprise Application Server, Data Server, and Web Server. If the Data Server is not stopped, an error message states that a component move data error has occurred.

**Note:** When uninstalling Oracle's Enterprise Performance Management products, please uninstall Hyperion Enterprise and Enterprise Reporting first. If the Enterprise Performance Management products are uninstalled first, you will not be able to remove Hyperion Enterprise and Enterprise Reporting.

➢ To uninstall Hyperion Enterprise:

1. From Windows desktop, select **Start > Settings > Control Panel > Add/Remove Programs.**
2. In **Add or Remove Programs**, select **Hyperion Enterprise**, and click **Change/Remove.**

   The Setup Type dialog box is displayed.
3 Select **Remove Enterprise** and all its components, and Click **Next**.

4 In the Confirm uninstallation message box, Click **OK**.

**Note:** The Hyperion Enterprise folder is not removed after an uninstall. The Hyperion Enterprise folder contains the `HSvrCtrl.dat` file and two log files. This folder must be manually removed.
Upgrading Methods

With this release of Hyperion Enterprise, you can upgrade 6.4.0.0.000 releases of Hyperion Enterprise quickly and seamlessly. This capability enables Hyperion Solutions Corporation to offer effective and efficient service fixes for earlier software releases.

You can modify installations by adding components that you did not choose to install earlier.

Also, you can repair installations.

Choose from the following Installation methods to upgrade Hyperion Enterprise:

1. Installing
2. Modifying
3. Repairing

Upgrading by Installing

Upgrading by Installing updates only Hyperion Enterprise Release 6.4.0.0.000 and later. Only the Hyperion Enterprise components that you had installed earlier are upgraded. You can run a complete install to upgrade these types of installations:

1. Workstation installation
2. Installation of Hyperion Enterprise Windows 32 bit, with any of these components:
   a. Application Server
   b. Data Server
   c. Web Server
   d. Message Server
   e. Add-On Module
f. Utility

g. Combination of Application Server, Data Server, Web Server, Message Server, Add-On Module, or Utility

**Note:** You can upgrade to a later version only if you have Hyperion Enterprise 6.4.0.0.000 or later installed on your system. If you have an earlier version installed on your system, you must uninstall and install Hyperion Enterprise on your system.

To install Hyperion Enterprise:

1. **Take one of these actions:**
   - If you downloaded the Hyperion Enterprise software from the Oracle E-Delivery, take one of these steps:
     - Navigate to the directory where you downloaded the installation program, then double-click `install.exe`.
     - From the Windows Start menu, select Run, type the following command in the Run dialog box, and click OK:
       ```bash
       Drive\directory\install.exe
       ```
     where Drive and directory are the location of the Hyperion Enterprise installer.

   The Select Install Language dialog box is displayed.
2 In the Select Install Language dialog box, select a language, then click OK.

Note: The default language is set to English.

A message is displayed to say that the setup program is being prepared:

When the setup program is ready, its Welcome screen is displayed:
3 Click Next.

A message is displayed to tell you that the setup program is installing Hyperion Enterprise:

![Install progress](image)

**Note:** The Hyperion Enterprise Web Server Setup dialog opens if you have a 6.4.0.0.000 or later release of Hyperion Enterprise Web server installed. Provide the path and user information and click OK to complete the installation.

4 Provide information as requested by the installer to complete the upgrade.

**Upgrading by Modifying**

You can modify installations of Hyperion Enterprise. But, before you modify, you should upgrade.

To upgrade, see “Upgrading by Installing” on page 111.
To modify Hyperion Enterprise installations:

1. From the Windows desktop, Select Start > Settings > Control Panel.
2. In Control Panel, select Add or Remove Programs.
3. In Add or Remove Programs, under Hyperion Enterprise, click Change/Remove.

4. Select **Modify the Installation**, and click Next.
   The Select Components dialog box is displayed.
Select components and click Next.

If you select Enterprise Application Server, Data Server, and Web Server, see “Setting Up Server Components” on page 45.

**Upgrading by Repairing**

You can repair installations. But, before repairing, you should upgrade.

To upgrade, see “Upgrading by Installing” on page 111.

1. From the Windows desktop, Select Start > Settings > Control Panel.
2. In Control Panel, select Add or Remove Programs.
3. In Add or Remove Programs, under Hyperion Enterprise, click Change/Remove.
4. Select Repair the Installation and click Next.
5. Select a restarting option, and click Finish.
This chapter provides information on manual Web deployment procedures.

**Installing and Configuring Microsoft IIS**

To use Hyperion Enterprise Release 6.5.1.1.000 on the Web, you must configure the Microsoft Internet Information Server (IIS) 6.0 or later on the Hyperion Enterprise Web Server. If you are using a separate, dedicated computer to run the Web Server components of Hyperion Enterprise, you must configure IIS on that computer.

The Hyperion Enterprise Web Server is supported on Windows 2003 and Windows 2008 servers. After you have installed IIS on the Web Server, you can install the Web Application component.

**Note:** You can install IIS only on Windows 2003 or Windows 2008 Server computers. When you install Windows 2003 Web Edition or Enterprise Edition, IIS is installed and configured automatically. If you are using Windows 2008 Standard Edition, IIS will have to be installed separately, but the ASP.NET and IIS 6 Management Compatibility has to be enabled.

1. Make sure that your World Wide Web Publishing Service is running. To check this, select **Start > Settings > Control Panel > Services** and make sure that this service has a **Started** status.
2. Depending on the Windows operating system that you are using, Select either of these options:
   - For Windows 2003 Server, if Active Server Pages are not already installed, select **Start > Control Panel > Add Or Remove Programs > Add / Remove Windows Components > Application Server > Internet Information Services (IIS) > World Wide Web Service > Install Active Server Pages.**
   - For Windows 2008 Server, to check the status of Internet Information Services (IIS), perform these tasks:
     a. Select **Start > Administrative Tools > Server Manager > Roles.**
b. Right-click on Roles and select Add Roles.
c. Select Web Server (IIS) and click Next.
d. Introduction of Web Server page is displayed and click Next to continue.
e. Select ASP.NET, and IIS 6 Management Compatibility options in the role services panel to install Web server (IIS) and click Next.
f. Confirm installation selection for Web server (IIS) and click Install and close the window.

Verifying the IIS Installation

➤ To verify the IIS installation:
1. Depending on the Windows Operation system that you are using, select either of these options:
   - From the Windows 2008 Server Start menu, select Start > Administrative Tools > Server Manager > Configuration.
   - From the Windows 2003 Start menu, select Programs > Administrative Tools.
2. Double-click the Services icon.
   The Services dialog box is displayed.
3. From the Services list, select IIS Admin Service.
4. Take one of these actions:
   - If the status is started, click Stop. Click OK in the dialog box to stop the listed services. When the IIS Admin Service is stopped, click Start.
   - If the status is not started, click Start.

6. Click Close to close the Services dialog box.
7. Close the Control Panel.

Prerequisites for configuring IIS

Complete the following prerequisites to configure IIS:

- User and password information for anonymous user must be specified.
  For more information on specifying directories and user values, see “Setting Up Server Components” on page 45.
- The anonymous user must be a part of the local administrator’s group.
- Metadata must be already loaded into the application
Checking IIS Configuration

For configuring Hyperion Enterprise Web Server to access Hyperion Enterprise and Hyperion Enterprise Reporting, see “Configuring the Hyperion Enterprise Web Application” on page 72.

To check IIS configuration on Windows 2003 Server, do the following:

1. From the Windows desktop, select Start > Run, in the Open text box type inetmgr.
   The Internet Information Services (IIS) Manager dialog box is displayed.

2. In the left pane in the Internet Information Services dialog box, traverse to HEWeb virtual directory or the virtual directory specified during the installation of Hyperion Enterprise.

3. Right-click virtual directory and from drop-down menu select Properties.
   The <virtual directory name> Properties dialog box is displayed.

4. On the Virtual Directory tab:
   a. Select the Read check box.
   b. In the Application Settings group box enter the name of the virtual directory you have specified in the Application Name field.
   c. In the Execute Permissions drop-down list, select Scripts Only.

   Note: Do not set the Execute Permissions drop-down list value to None.
   d. In the Application Protection drop-down list, select Low (IIS Process).

5. On the Directory Security tab:
   a. In the Authentication and access control group box, select Edit.
      The Authentication Methods dialog box is displayed.
   b. In the Authentication Methods dialog box, select the Enable anonymous access check box.
      The User name and Password text boxes in the Enable Anonymous Access group box are now editable.
   c. In the Enable Anonymous Access group box, enter username or click Browse.
      The Select User dialog box is displayed.
   d. In the Select User dialog box, select username from the Select User dialog box, then type password.
   e. Click OK to save values in Authentication Methods dialog box.

6. Click Apply, then click OK in the <virtual directory name> Properties dialog box.

To check IIS configuration on Windows 2008 Server, complete the following tasks:

1. From the Windows desktop, select Start > Run, in the Open text box type inetmgr.
   The Internet Information Services (IIS) Manager dialog box is displayed.
In the left pane in the Internet Information Services dialog box, traverse to HEWeb virtual directory or the virtual directory specified during the installation of Hyperion Enterprise.

In the right pane of the virtual directory, under IIS section, double-click on the **Handler Mappings** icon. The Handler Mappings dialog box is displayed.

Under the action pane, select **Edit Feature Permissions** link.

Select the **Read**, **Script** and **Execute** check boxes and click **OK**.

In the right pane of the virtual directory, under IIS section, double-click on the **Authentication** icon. The Authentication dialog box is displayed.

In the Authentication dialog box, select the **Anonymous Authentication**.

To enable the Anonymous Authentication, complete this task:

Under the action pane, select **Enable** option for the Anonymous Authentication.

To edit the Anonymous Authentication details, perform these tasks:

a. Under the action pane, select **Edit**.

The **Edit Anonymous Authentication Credentials** dialog box is displayed.

b. Select **Specific user** option and click **Set**.

The User name and Password text boxes in the **Set Credentials** box are now editable.

c. In the **Set Credentials** box, enter username and password.

d. Click **OK** to save values in Authentication dialog box.

e. Click **OK** to close the **Edit Anonymous Authentication Credentials** dialog box.

**Performance Tuning**

It is recommended that you adjust the performance tuning for the server in Windows. This adjustment reduces the internal system priority of foreground applications.

To adjust performance:

1. From the Windows **Start** menu, select **Settings > Control Panel**.
2. From the Control Panel, double-click the **System** icon.
3. From the System Properties dialog box, select the **Performance** tab.
4. Drag the Application Performance slider bar to **None**.

Consider following server updates for improved performance:

- RAID controller should be set to 50/50 read/write.
- Hyperthreading should be turned off.
- If Terminal Services\Citrix is being used with a backend file server, NICs on all the servers should be set to Full Duplex.
- Anti-virus software real-time scan should exclude application and program folders. Alternatively disable real-time scanning and run full system scans at scheduled down-times.
Hyperion Enterprise documentation includes online browser-based help for Hyperion Enterprise Windows 32–bit client and Web, and portable document format (PDF) files. This appendix provides information about the documentation and its use.

**Browser-Based Help for Hyperion Enterprise Windows 32–bit client and Web**

Browser-Based Help for Hyperion Enterprise Windows 32–bit client and Web give you immediate answers to many common questions. If you want information about a specific dialog box or Web page, make sure the dialog box or Web page is open and active.

**Accessing Browser-Based Help for Hyperion Enterprise Windows 32–bit client**

Each Hyperion Enterprise product is installed with browser-based help.

The browser-based help contains the following types of information:

- Procedural information that you need to complete tasks in Hyperion Enterprise
- Window and dialog box explanations

To access the online help, use any of these methods:

- Select Help > Contents while using the product.
- Press F1 while in the product.
- Click the Help button in a dialog box.
Accessing Browser-Based Help

➢ To access the browser-based help, click the Help button at the top of the Web page.

➢ To print a browser-based help topic, display the topic, then right click in the topic and click Print.

Viewing and Printing PDF Files

PDF files are electronic versions of Hyperion Enterprise documentation. They contain conceptual and procedural information, as well as examples, to assist you in using Hyperion Enterprise.

You use Adobe Acrobat Reader to view and print PDF documents. The PDF documents in this installation are compatible only with Adobe Acrobat Reader 7.0 and later. If you have an earlier release of Acrobat Reader on your computer, you must install later releases from the Adobe Web site at http://www.adobe.com.

➢ To view and print a PDF file:

1. Open the file by one of these methods:
   - From the Windows, start Acrobat Reader icon, then open a PDF file from your Hyperion Solutions directory.

2. To print the document, select File > Print, specify which pages you want to print and the number of copies, then click OK.

PDF Files for Hyperion Enterprise

The setup program installs the Hyperion Enterprise PDF files shown in Table 17.

<table>
<thead>
<tr>
<th>File Name</th>
<th>Document</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ace.pdf</td>
<td>Hyperion Enterprise Statutory Consolidation Engine Guide</td>
</tr>
<tr>
<td>Admin.pdf</td>
<td>Hyperion Enterprise Administrator’s Guide</td>
</tr>
<tr>
<td>Api.pdf</td>
<td>Hyperion Enterprise API Reference Guide</td>
</tr>
<tr>
<td>GetStart.pdf</td>
<td>Hyperion Enterprise Getting Started Guide</td>
</tr>
<tr>
<td>User.pdf</td>
<td>Hyperion Enterprise User’s Guide</td>
</tr>
</tbody>
</table>
In This Appendix

**Windows System Files** .................................................................................................................. 125

**Windows Registry Files** .............................................................................................................. 126

**Windows Crystal Files** ................................................................................................................. 127

**Windows Crescent Files** ............................................................................................................... 128

This appendix shows the program files installed in your Windows system directories during installation. The files you receive are dependent on your operating system.

### Windows System Files

<table>
<thead>
<tr>
<th>Filename</th>
<th>Date/Time</th>
<th>Size</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vbscript.dll</td>
<td>09/13/1999 07:59:34</td>
<td>426,256</td>
<td>5.0.0.3715</td>
</tr>
<tr>
<td>Cmpsfx32.dll</td>
<td>10/12/2000 11:12:48</td>
<td>75,264</td>
<td>4.0.0.26</td>
</tr>
<tr>
<td>Co2c40en.dll</td>
<td>11/18/1996 00:00:00</td>
<td>748,160</td>
<td>4.6.3.106</td>
</tr>
<tr>
<td>Compl32.dll</td>
<td>10/12/2000 11:12:48</td>
<td>239,616</td>
<td>4.1.0.9</td>
</tr>
<tr>
<td>Crpe32.dll</td>
<td>06/21/1999 05:00:00</td>
<td>5,797,888</td>
<td>7.0.100.15</td>
</tr>
<tr>
<td>Implode.dll</td>
<td>11/18/1996 00:00:00</td>
<td>18,944</td>
<td>1.0.0.1</td>
</tr>
<tr>
<td>Mfcans32.dll</td>
<td>10/12/2000 11:12:50</td>
<td>133,904</td>
<td>3.2.2.0</td>
</tr>
<tr>
<td>Mfcuia32.dll</td>
<td>07/11/1995 09:50:00</td>
<td>5,632</td>
<td>3.0.0.0</td>
</tr>
<tr>
<td>msvcirt.dll</td>
<td>06/17/1998 12:00:00</td>
<td>77,878</td>
<td>6.0.8168.0</td>
</tr>
<tr>
<td>Msvcr.dll</td>
<td>02/02/1999 12:00:00</td>
<td>266,293</td>
<td>6.0.8397.0</td>
</tr>
<tr>
<td>msvcr20.dll</td>
<td>10/12/2000 11:12:50</td>
<td>253,952</td>
<td>2.11.0.0</td>
</tr>
<tr>
<td>msvcr40.dll</td>
<td>02/08/1999 12:00:00</td>
<td>326,656</td>
<td>4.22.0.0</td>
</tr>
<tr>
<td>P2bbnd.dll</td>
<td>11/18/1996 00:00:00</td>
<td>36,352</td>
<td>4.6.3.106</td>
</tr>
<tr>
<td>P2bdao.dll</td>
<td>11/20/1996 00:00:00</td>
<td>87,040</td>
<td>4.6.3.112</td>
</tr>
<tr>
<td>P2ctdao.dll</td>
<td>11/18/1996 00:00:00</td>
<td>50,176</td>
<td>4.6.3.106</td>
</tr>
<tr>
<td>P2irdao.dll</td>
<td>11/18/1996 00:00:00</td>
<td>54,272</td>
<td>4.6.3.106</td>
</tr>
</tbody>
</table>
Windows Registry Files

Filename Date Time Size Version
Wrapmail.ocx 10/12/2000 11:12:58 398,848 1.1.0.36
Comcat.dll 10/12/2000 11:12:52 22,288 4.71.1441.1
Comct232.ocx 07/19/1997 16:00:18 155,920 5.1.43.19
Comctl32.ocx 07/19/1997 16:00:28 604,432 5.1.43.19
Comdlg32.ocx 05/07/1999 12:00:00 140,288 6.0.84.18
Dao2535.tlb 12/05/1996 00:00:00 73,184

P2sodbc.dll 11/18/1996 00:00:00 131,072 4.6.3.106
Pg32.dll 11/18/1996 00:00:00 979,456 1.0.0.11
qpro32.dll 10/12/2000 11:12:52 118,272 4.20.0.0
vbamap32.dll 10/12/2000 11:12:52 14,848 2.1.0.0
Vb5stkit.dll 01/16/1997 00:00:00 29,696 5.0.37.16
vbajet32.dll 01/22/1999 12:00:00 30,992 6.0.1.8268
Asycfilt.dll 10/12/2000 11:12:48 147,728 2.40.4275.1
Book.abx 10/12/2000 11:12:48 1,558
Mapsm32x.dll 10/12/2000 11:12:50 921,600 2.0.0.5
Mavim32x.dll 10/12/2000 11:12:50 505,344 2.0.0.5
Cp5dll32.dll 10/12/2000 11:12:48 216,064 5.0.0.112
Roboex32.dll 10/27/1998 11:08:04 317,952 7.0.142.0
Msvcp60.dll 06/17/1998 12:00:00 401,462 6.0.8168.0
Apigid32.dll 10/12/2000 11:12:48 113,664 4.0.0.0
Compobj.dll 10/12/2000 11:12:48 30,400 2.10.35.35
Dzip32.dll 10/12/2000 11:12:48 124,416 3.0.0.15
Gapi32.dll 10/12/2000 11:12:48 98,304 5.5.1960.0
Idsnotes.dll 10/12/2000 11:12:50 45,056 1.0.0.1
Ole2.dll 10/12/2000 11:12:50 39,744 2.10.35.35
Ole2disp.dll 10/12/2000 11:12:50 169,520 2.10.3029.1
Ole2nls.dll 10/12/2000 11:12:52 153008 2.10.3029.1
Stdoile2.tlb 10/12/2000 11:12:52 17,920 2.40.4275.1
Storage.dll 10/12/2000 11:12:52 4,208 2.10.35.35
Typelib.dll 10/12/2000 11:12:52 177,856 2.10.3029.1
Spr32x30.ocx 09/21/1999 02:32:10 992,968 3.0.0.16
Mfc40.dll 04/29/1999 12:04:00 924,432 4.1.0.6140
Mfc42.dll 04/27/1999 12:00:00 995,383 6.0.8447.0
Mscomm32.ocx 06/24/1998 12:00:00 103,744 6.0.81.69
Msvbvm50.dll 07/19/1997 15:55:40 1,347,344 5.1.43.19
Oleaut32.dll 10/12/2000 11:12:56 598,288 2.40.4275.11
Olepro32.dll 10/12/2000 11:12:56 164,112 5.0.4275.1
Ss32x25.ocx 10/12/2000 11:12:56 703,984 2.5.0.20
Stdole2.tlb 03/08/1999 12:02:26 17,920 2.40.4275.1
Tdbg6.ocx 10/12/2000 11:12:58 819,688 6.0.0.235
Threed32.ocx 10/12/2000 11:12:58 200,704 1.0.41.0
Vsocx32.ocx 10/12/2000 11:12:58 151,552 5.0.5.50
Atl.dll 03/25/1999 07:42:10 73,785 3.0.8449.0
Cp50cc32.ocx 10/12/2000 11:12:52 93,696 5.0.0.105
Tabctl32.ocx 05/07/1999 12:00:00 209,408 6.0.84.18
Mscomct2.ocx 05/07/1999 12:00:00 645,616 6.0.84.18
Mscomctl.ocx 05/13/1999 12:00:00 1,064,456 6.0.84.98
Msvbvm60.dll 05/10/1999 12:00:00 1,384,448 6.0.84.95
Dssock32.ocx 10/12/2000 11:12:54 48,640 1.65.0.1
Filename Date Time Size Version
Dzocx32.ocx 10/12/2000 11:12:54 73,216 1.0.0.5
Oc30.dll 10/12/2000 11:12:56 640,512 3.20.0.0
Olemmsg32.dll 10/12/2000 11:12:56 285,968 5.0.1460.8
Idsmai32.exe 10/12/2000 11:12:54 1,161,728 6.3.0.0

Windows Crystal Files
Filename Date Time Size Version
U2fxls.dll 11/18/1996 00:00:00 69,632 4.6.3.106
U2ddisk.dll 11/18/1996 00:00:00 45,056 4.6.3.106
U2dmapi.dll 11/18/1996 00:00:00 124,256 4.6.3.106
U2fcr.dll 11/18/1996 00:00:00 97,489 4.6.3.106
U2dif.dll 11/18/1996 00:00:00 49,152 4.6.3.106
U2fhtml.dll 11/18/1996 00:00:00 109,568 4.6.3.106
<table>
<thead>
<tr>
<th>Filename</th>
<th>Date</th>
<th>Time</th>
<th>Size</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>csvlst32.ocx</td>
<td>07/08/1999</td>
<td>16:44:54</td>
<td>91,648</td>
<td>4.40.0.0</td>
</tr>
<tr>
<td>cschk32.ocx</td>
<td>07/08/1999</td>
<td>16:44:22</td>
<td>100,864</td>
<td>4.40.0.0</td>
</tr>
<tr>
<td>cscmd32.ocx</td>
<td>07/08/1999</td>
<td>16:47:04</td>
<td>100,864</td>
<td>4.41.0.0</td>
</tr>
<tr>
<td>cscomb32.ocx</td>
<td>07/08/1999</td>
<td>16:44:22</td>
<td>111,104</td>
<td>4.40.0.0</td>
</tr>
<tr>
<td>csform32.ocx</td>
<td>07/08/1999</td>
<td>16:44:22</td>
<td>91,136</td>
<td>4.40.0.0</td>
</tr>
<tr>
<td>cslist32.ocx</td>
<td>07/08/1999</td>
<td>16:44:38</td>
<td>83,456</td>
<td>4.40.0.0</td>
</tr>
<tr>
<td>csmete32.ocx</td>
<td>07/08/1999</td>
<td>16:44:38</td>
<td>68,608</td>
<td>4.40.0.0</td>
</tr>
<tr>
<td>csopt32.ocx</td>
<td>07/08/1999</td>
<td>16:44:38</td>
<td>96,768</td>
<td>4.40.0.0</td>
</tr>
<tr>
<td>cspict32.ocx</td>
<td>07/08/1999</td>
<td>16:44:54</td>
<td>81,408</td>
<td>4.40.0.0</td>
</tr>
<tr>
<td>csplst32.ocx</td>
<td>07/08/1999</td>
<td>16:44:54</td>
<td>100,864</td>
<td>4.40.0.0</td>
</tr>
<tr>
<td>csspin32.ocx</td>
<td>07/08/1999</td>
<td>16:44:54</td>
<td>79,360</td>
<td>4.40.0.0</td>
</tr>
<tr>
<td>cstext32.ocx</td>
<td>05/28/1999</td>
<td>10:43:40</td>
<td>399,360</td>
<td>4.42.0.0</td>
</tr>
<tr>
<td>Crystl32.ocx</td>
<td>06/21/1999</td>
<td>05:00:00</td>
<td>993,996</td>
<td>6.3.0.609</td>
</tr>
</tbody>
</table>

**Windows Crescent Files**

Filename Date Time Size Version

<table>
<thead>
<tr>
<th>Filename</th>
<th>Date</th>
<th>Time</th>
<th>Size</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>U2frec.dll</td>
<td>11/18/1996</td>
<td>00:00:00</td>
<td>49,152</td>
<td>4.6.3.106</td>
</tr>
<tr>
<td>U2frtf.dll</td>
<td>11/18/1996</td>
<td>00:00:00</td>
<td>153,761</td>
<td>4.6.3.106</td>
</tr>
<tr>
<td>U2fsepv.dll</td>
<td>11/18/1996</td>
<td>00:00:00</td>
<td>53,248</td>
<td>4.6.3.106</td>
</tr>
<tr>
<td>U2ftext.dll</td>
<td>11/18/1996</td>
<td>00:00:00</td>
<td>53,248</td>
<td>4.6.3.106</td>
</tr>
<tr>
<td>U2fwks.dll</td>
<td>11/18/1996</td>
<td>00:00:00</td>
<td>53,248</td>
<td>4.6.3.106</td>
</tr>
<tr>
<td>U2fwordw.dll</td>
<td>11/18/1996</td>
<td>00:00:00</td>
<td>69,632</td>
<td>4.6.3.106</td>
</tr>
<tr>
<td>Crxlat32.dll</td>
<td>11/18/1996</td>
<td>00:00:00</td>
<td>39,936</td>
<td>4.6.3.106</td>
</tr>
</tbody>
</table>

**Program Files Inventory**
This appendix describes the products that are shipped with this release.

**Hyperion Enterprise**

Hyperion Enterprise is an advanced financial management reporting and consolidation system. Hyperion Enterprise consolidates data from multiple sources and diverse general ledgers within an enterprise to provide a consistent, global view of information.

**Hyperion Enterprise API Reference Guide**

The *Hyperion Enterprise API Reference Guide* provides a set of functions that allow high-level access to the Hyperion Enterprise application program interface (API) from any program.

**Hyperion Allocations**

Hyperion Allocations provides a set of allocation methods to manipulate data directly within your Hyperion Enterprise application. It handles allocations across entities, periods, and
accounts and enables the designer to define allocation rules and methods using a graphical allocation builder.

**Hyperion LedgerLink**

Hyperion LedgerLink automates the process of translating and importing data into Hyperion Enterprise. It integrates third-party general ledger and additional feeder system data by using templates applicable to specific vendor applications.

**Statutory Consolidation Engine (SCE)**

SCE is an add-on product that works with Hyperion Enterprise to improve consolidation performance and functionality for statutory applications.

**Hyperion Retrieve**

Hyperion Retrieve is an add-in to Microsoft Excel and is used to move data between the Hyperion Enterprise product applications and Excel worksheets. For example, when working in an Excel worksheet, you can retrieve data from a Hyperion Enterprise application to include in the worksheet.

**Hyperion AutoPilot**

Hyperion AutoPilot is a graphical tool for automating Hyperion Solutions’ product tasks, such as loading data files, consolidating, and running a book or reports, by grouping them into a single task flow.

**Application Conversion SE to 6.5.1.1.000 Conversion Wizard**

This wizard converts applications built in Hyperion Enterprise SE to Release 6.5.1.1.000.

**Application Conversion 4.7 Through 6.3.0.0.000 to 6.5.1.1.000**

There is no longer a conversion wizard for Release 4.6 through Release 5.x. You must either rebuild the Release 4.6 application in Release 6.5.1.1.000 or convert the Release 4.6 application to Release 4.7 using the Release 4.7 conversion utility and then use the Release 4.7 through Release 6.5.1.1.000 conversion utility that is available in Release 6.5.1.1.000.
Load File Conversion Utility
The Load File Conversion Utility converts load files from Hyperion Enterprise SE Release 1.8.x or Hyperion Enterprise SE Release 4.x to Release 6.3.0.0.000

Logic File Conversion Utility
The Logic File Conversion Utility converts logic files from Hyperion Enterprise SE Release 1.8.x or Oracle's Hyperion® Enterprise® SE Release 4.x to Release 6.5.1.000.

Hyperion Home Migration Utility
With Hyperion Home Migration Utility you can move the location of the common directory Hyperion Home.
About Default Ports

During Oracle Hyperion Enterprise Performance Management System product deployments, default port numbers for application servers are automatically populated. During configuration, you can change the default numbers. Each port number must be unique. If an error message similar to “port already in use” or “bind error” is displayed, a port number conflict might exist.

If the default port number is not changed, the software is configured with the default values.

Shared Services Ports

Table 18  Shared Services Web Application Ports

<table>
<thead>
<tr>
<th>Port Type</th>
<th>Default Port Number</th>
<th>Where Configurable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Listen port</td>
<td>58080</td>
<td>Oracle's Hyperion Enterprise Performance Management System Configurator</td>
</tr>
<tr>
<td>SSL listen port</td>
<td>NA</td>
<td>Application server administration console (configure manually)</td>
</tr>
<tr>
<td>Shutdown Port for Apache Tomcat</td>
<td>58081</td>
<td>Application server administration console (configure manually)</td>
</tr>
<tr>
<td>AJP connector port</td>
<td>58082</td>
<td>Application server administration console (configure manually)</td>
</tr>
</tbody>
</table>

Table 19  Shared Services Default Service Ports

<table>
<thead>
<tr>
<th>Service</th>
<th>Default Port Number</th>
<th>Where Configurable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle's Hyperion® Remote</td>
<td>58000</td>
<td>Oracle's Hyperion® Remote Authentication Module installation program</td>
</tr>
<tr>
<td>Service</td>
<td>Default Port Number</td>
<td>Where Configurable</td>
</tr>
<tr>
<td>-------------------------</td>
<td>---------------------</td>
<td>--------------------------------------------------------</td>
</tr>
<tr>
<td>Authentication Module</td>
<td>Additional dynamic port (1)</td>
<td>Not configurable</td>
</tr>
<tr>
<td>OpenLDAP</td>
<td>58089</td>
<td>- UNIX: <code>&lt;HSS_HOME&gt;/openLDAP/startOpenLDAP.sh</code></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Windows: Run <code>slapd -d 1 -f slapd.conf -h ldap://hostname:portnumber</code></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- UNIX and Windows: CSS.xml:</td>
</tr>
<tr>
<td></td>
<td></td>
<td><code>&lt;hub location=http://localhost:HSS Port&gt;</code></td>
</tr>
<tr>
<td></td>
<td></td>
<td><code>&lt;dirPort&gt;openLDAP Port&lt;/dirPort&gt;</code></td>
</tr>
<tr>
<td></td>
<td></td>
<td><code>&lt;/hub&gt;</code></td>
</tr>
</tbody>
</table>

**Essbase – System 9 Ports**

- “Essbase Ports” on page 134.
- “Administration Services Ports” on page 135.
- “Provider Services Ports” on page 136.
- “Smart Search Command Line Utility Ports” on page 137.

**Essbase Ports**

**Table 20  Essbase Default Service Ports**

<table>
<thead>
<tr>
<th>Service</th>
<th>Default Port Number</th>
<th>Where Configurable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle Essbase Agent</td>
<td>1423</td>
<td>- EPM System Configurator</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Essbase configuration file (<code>ARBORPATH\bin\Essbase.cfg</code>)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Modify the file to include AgentPort.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For instructions, see the <em>Essbase Technical Reference</em>, “Essbase.cfg Configuration Settings.”</td>
</tr>
<tr>
<td>Essbase server applications (ESSSVR)</td>
<td>32768-33768 (two ports per process)</td>
<td>Oracle Essbase configuration file (<code>ARBORPATH\bin\Essbase.cfg</code>)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>To limit the range and set the increment for these ports, modify the file to include these settings: ServerPortBegin, ServerPortEnd, PortInc</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For instructions, see the <em>Essbase Technical Reference</em>, “Essbase.cfg Configuration Settings.”</td>
</tr>
<tr>
<td>Oracle Essbase Integration Services Server</td>
<td>3388</td>
<td><code>&lt;AIS_HOME&gt;/bin/ais.cfg</code> Add <code>-Pportnumber</code></td>
</tr>
</tbody>
</table>
## Administration Services Ports

### Table 21  Administration Services Web Application Ports

<table>
<thead>
<tr>
<th>Port Type</th>
<th>Default Port Number</th>
<th>Where Configurable</th>
</tr>
</thead>
</table>
| Listen port | 10080 | - EPM System Configurator  
- Default Tomcat deployment: `<aas_home>/deployments/tomcat/5.0.2.8/conf/server.xml`  
  Parameter: Connector port  
- Deployed Tomcat deployment (via EPM System Configurator): `<Hyperion_Home>/deployments/<AppServNameAndVersion>/aas/conf/server.xml`  
  Parameter: Connector port  
- WebLogic and WebSphere: Application server administration console |
| SSL listen port | 10090 | - Default Tomcat deployment: `<aas_home>/deployments/tomcat/5.0.28/conf/server.xml`  
  Parameter: Connector port  
- Deployed Tomcat deployment (via EPM System Configurator): `<Hyperion_Home>/deployments/<AppServNameAndVersion>/aas/conf/server.xml`  
  Parameter: Connector port  
- WebLogic and WebSphere: Application server administration console |
| Shutdown port for Apache Tomcat | 10081  
For default Tomcat deployment only: 10005 | - Deployed Tomcat deployment (via EPM System Configurator): `<Hyperion_Home>/deployments/<AppServNameAndVersion>/aas/conf/server.xml`  
  Parameter: Connector port  
- Default Tomcat deployment: `<aas_home>/deployments/tomcat/5.0.28/conf/server.xml`  
  Parameter: Connector port  
- WebLogic and WebSphere: Application server administration console |
| AJP connector port | 10082  
For default Tomcat deployment only: NA | - Deployed Tomcat deployment (via EPM System Configurator): `<Hyperion_Home>/deployments/<AppServNameAndVersion>/aas/conf/server.xml`  
  Parameter: Connector port  
- Default Tomcat deployment: NA  
- WebLogic and WebSphere: Application server administration console |
## Provider Services Ports

<table>
<thead>
<tr>
<th>Port Type</th>
<th>Default Port Number</th>
<th>Where Configurable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Listen port</td>
<td>13080</td>
<td>- EPM System Configurator</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Default Tomcat deployment: <code>&lt;aps_home&gt;/deployments/tomcat/5.0.28/conf/server.xml</code></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Parameter: Connector port</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Deployed Tomcat deployment (via EPM System Configurator): <code>&lt;Hyperion_Home&gt;/deployments/&lt;AppServNameAndVersion&gt;/aps/conf/server.xml</code></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Parameter: Connector port</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- WebLogic and WebSphere: Application server administration console</td>
</tr>
<tr>
<td>SSL listen port</td>
<td>13090</td>
<td>- Default Tomcat deployment: <code>&lt;aps_home&gt;/deployments/tomcat/5.0.28/conf/server.xml</code></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Parameter: Connector port</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Deployed Tomcat deployment (via EPM System Configurator): <code>&lt;Hyperion_Home&gt;/deployments/&lt;AppServNameAndVersion&gt;/aps/conf/server.xml</code></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Parameter: Connector port</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- WebLogic and WebSphere: Application server administration console</td>
</tr>
<tr>
<td>Shutdown port for Apache Tomcat</td>
<td>13081</td>
<td>- Deployed Tomcat deployment (via EPM System Configurator): <code>&lt;Hyperion_Home&gt;/deployments/&lt;AppServNameAndVersion&gt;/aps/conf/server.xml</code></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Parameter: Connector port</td>
</tr>
<tr>
<td></td>
<td>For default Tomcat deployment only:</td>
<td>13005</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Default Tomcat deployment: <code>&lt;aps_home&gt;/deployments/tomcat/5.0.28/conf/server.xml</code></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Parameter: Connector port</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Deployed Tomcat deployment (via EPM System Configurator): <code>&lt;Hyperion_Home&gt;/deployments/&lt;AppServNameAndVersion&gt;/aps/conf/server.xml</code></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Parameter: Connector port</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- WebLogic and WebSphere: Application server administration console</td>
</tr>
<tr>
<td>AJP connector port</td>
<td>13082</td>
<td>- Deployed Tomcat deployment (via EPM System Configurator): <code>&lt;Hyperion_Home&gt;/deployments/&lt;AppServNameAndVersion&gt;/aps/conf/server.xml</code></td>
</tr>
<tr>
<td></td>
<td>For default Tomcat deployment only:</td>
<td>NA</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Parameter: Connector port</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Default Tomcat deployment: NA</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- WebLogic and WebSphere: Application server administration console</td>
</tr>
</tbody>
</table>
**Smart Search Command Line Utility Ports**

Table 23  Smart Search Command Line Utility Web Application Ports

<table>
<thead>
<tr>
<th>Port Type</th>
<th>Default Port Number</th>
<th>Where Configurable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Listen port</td>
<td>16080</td>
<td>Default Tomcat deployment: <code>&lt;Hyperion_Home&gt;/deployments/tomcat5/conf/server.xml</code></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Parameter: Connector port</td>
</tr>
<tr>
<td>SSL listen port</td>
<td>NA</td>
<td>NA</td>
</tr>
<tr>
<td>Shutdown port for Apache Tomcat</td>
<td>16081</td>
<td>Default Tomcat deployment: <code>&lt;Hyperion_Home&gt;/deployments/tomcat5/conf/server.xml</code></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Parameter: Server port</td>
</tr>
<tr>
<td>AJP connector port</td>
<td>NA</td>
<td>NA</td>
</tr>
</tbody>
</table>

**Reporting and Analysis Ports**

- “Foundation Ports” on page 137.
- “Interactive Reporting Ports” on page 139.
- “Web Analysis Ports” on page 139.
- “EPM Workspace Ports” on page 140.
- “Application Builder for J2EE Ports” on page 141.
- “Application Builder for .NET Ports” on page 141.

**Foundation Ports**

Table 24  Reporting and Analysis Default Service Ports

<table>
<thead>
<tr>
<th>Service</th>
<th>Default Port Number</th>
<th>Where Configurable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Foundation</td>
<td>6790 – 6810</td>
<td>See below for detail on each port.</td>
</tr>
<tr>
<td>Global Services Manager (GSM)</td>
<td>6800</td>
<td>● EPM System Configurator</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● <code>&lt;BIPLUS_HOME&gt;/common/config/server.xml</code></td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;host&gt;machine.domain&lt;/host&gt;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;port&gt;portNumber&lt;/port&gt;</td>
</tr>
<tr>
<td>Core Service</td>
<td>6801</td>
<td></td>
</tr>
</tbody>
</table>
### Service Default Port Number

| Name Service       | 6798 | EPM System Configurator  
|                   |      | `<$BIPLUS_HOME>/common/config/config.dat`  
|                   |      | Parameter: Port  
|                   |      | See the Hyperion Workspace Administrator's Guide.  
| Service Broker     | 6797 | Remote Service Configurator  
| Job Service        | 6796 | See the Hyperion Workspace Administrator's Guide.  
| Event Service      | 6794 |  
| Repository Service | 6795 |  

### Table 25 Reporting and Analysis Web Server Port

<table>
<thead>
<tr>
<th>Server</th>
<th>Default Server Port</th>
<th>Where Configurable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apache and IBM</td>
<td>19000</td>
<td><code>&lt;$APACHE_HOME&gt;/conf/httpd.conf</code></td>
</tr>
<tr>
<td>IIS and Oracle HTTP Server</td>
<td>80</td>
<td>Microsoft Internet Information Services (IIS) Manager Console. (Change the TCP port value setting.)</td>
</tr>
</tbody>
</table>

### Financial Reporting Ports

### Table 26 Financial Reporting Web Application Ports

<table>
<thead>
<tr>
<th>Port Type</th>
<th>Default Port Number</th>
<th>Where Configurable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Listen port</td>
<td>8200</td>
<td>EPM System Configurator</td>
</tr>
<tr>
<td>SSL listen port</td>
<td>NA</td>
<td>Application server administration console (configure manually)</td>
</tr>
</tbody>
</table>
| Shutdown port for Apache Tomcat | 8201               | Application server administration console (configure manually).  
|                             |                     | **Note:** The port number depends on the listen port (listen port + 1).          |
| AJP connector port          | 8202                | `<$HYPERION_HOME>/common/httpserver/Apache/2.0.52/conf/HYSLWorkers.properties`   
|                             |                     | worker.Financial_Reporting.host=hostname.company.com                            
|                             |                     | worker.Financial_Reporting.port=portNumber                                       
|                             |                     | worker.Financial_Reporting.type=ajp13                                            
|                             |                     | **Note:** The port number depends on the listen port (listen port + 2).          |
### Table 27  Financial Reporting Default Service Ports

<table>
<thead>
<tr>
<th>Service</th>
<th>Default Port Number</th>
<th>Where Configurable</th>
</tr>
</thead>
</table>
Parameters: HRRepSvrPort1, HRRepSvrPort2                                      |
| Financial Reporting Scheduler Service                                   | Dynamic             | `<BIPLUS_HOME>/lib/fr_scheduler.properties`  
Parameter: HRSchdSvrPort                                                    |
| Financial Reporting Print Service                                       | Dynamic             | `<BIPLUS_HOME>/lib/fr_printserver.properties`  
Parameter: HRPrintSvrPort                                                   |
Parameter: RMIorPort                                                        |

Additional dynamic port (1) Not configurable

### Interactive Reporting Ports

### Table 28  Interactive Reporting Default Service Ports

<table>
<thead>
<tr>
<th>Service</th>
<th>Default Port Number</th>
<th>Where Configurable</th>
</tr>
</thead>
</table>
| Data Access Service (DAS)            | 6811, 6812          | `<BIPLUS_HOME>/common/config/irmconfig.xml`  
Default Ports = portNumber, portNumber                                          |
| Oracle's Hyperion® Interactive Reporting Service | 6813, 6814 | `<BIPLUS_HOME>/common/config/irmconfig.xml`  
Default Ports = portNumber, portNumber                                            |
| Job Service                          | 6815                | `<BIPLUS_HOME>/common/config/irmconfig.xml`  
Default Ports = portNumber                                                        |
| Log Service                          | 6810                | `<BIPLUS_HOME>/common/config/irmconfig.xml`  
Default Ports = portNumber                                                        |

### Web Analysis Ports

### Table 29  Web Analysis Web Application Ports

<table>
<thead>
<tr>
<th>Port Type</th>
<th>Default Port Number</th>
<th>Where Configurable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Listen port</td>
<td>16000</td>
<td>EPM System Configurator</td>
</tr>
<tr>
<td>Additional listen ports (2)</td>
<td>Dynamic</td>
<td>Not configurable</td>
</tr>
<tr>
<td>Port Type</td>
<td>Default Port Number</td>
<td>Where Configurable</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>SSL listen port</td>
<td>NA</td>
<td>Application server administration console (configure manually)</td>
</tr>
<tr>
<td>Shutdown port for Apache Tomcat</td>
<td>16001</td>
<td>Application server administration console (configure manually). Note: The port number depends on the listen port (listen port + 1).</td>
</tr>
<tr>
<td>AJP connector port</td>
<td>16002</td>
<td><code>&lt;HYPERION_HOME&gt;/common/httpserver/Apache/2.0.52/conf/HYSLWorkers.properties</code></td>
</tr>
<tr>
<td></td>
<td></td>
<td>worker.Web_Analysis.host=hostname.company.com</td>
</tr>
<tr>
<td></td>
<td></td>
<td>worker.Web_Analysis.port=portNumber</td>
</tr>
<tr>
<td></td>
<td></td>
<td>worker.Web_Analysis.type=ajp13</td>
</tr>
<tr>
<td></td>
<td>Note: The port number depends on the listen port (listen port + 2).</td>
<td></td>
</tr>
</tbody>
</table>

## EPM Workspace Ports

### Table 30  EPM Workspace Web Application Ports

<table>
<thead>
<tr>
<th>Port Type</th>
<th>Default Port Number</th>
<th>Where Configurable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Listen port</td>
<td>45000</td>
<td>EPM System Configurator</td>
</tr>
<tr>
<td>Additional listen port (1)</td>
<td>Dynamic</td>
<td>Not configurable</td>
</tr>
<tr>
<td>SSL listen port</td>
<td>NA</td>
<td>Application server administration console (configure manually)</td>
</tr>
<tr>
<td>Shutdown port for Apache Tomcat</td>
<td>45001</td>
<td><code>&lt;BIPLUS_HOME&gt;/AppServer/InstalledApps/Tomcat/5.0.28/Workspace/conf/server.xml</code></td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;Server port=portNumber shutdown=SHUTDOWN&gt;</td>
</tr>
<tr>
<td></td>
<td>Note: The port number depends on the listen port (listen port + 1).</td>
<td></td>
</tr>
<tr>
<td>AJP connector port</td>
<td>45002</td>
<td><code>&lt;HYPERION_HOME&gt;/common/httpserver/Apache/2.0.59/conf/HYSLWorkers.properties</code></td>
</tr>
<tr>
<td></td>
<td></td>
<td>worker.Workspace.host=hostname.company.com</td>
</tr>
<tr>
<td></td>
<td></td>
<td>worker.Workspace.port=portNumber</td>
</tr>
<tr>
<td></td>
<td></td>
<td>worker.Workspace.type=ajp13</td>
</tr>
<tr>
<td></td>
<td>Note: The port number depends on the listen port (listen port + 2).</td>
<td></td>
</tr>
</tbody>
</table>
Application Builder for J2EE Ports

Table 31  Application Builder for J2EE Web Application Ports

<table>
<thead>
<tr>
<th>Port Type</th>
<th>Default Port Number</th>
<th>Where Configurable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Listen port</td>
<td>22080</td>
<td>Application server administration console (configure manually)</td>
</tr>
<tr>
<td>SSL listen port</td>
<td>22090</td>
<td>Application server administration console (configure manually)</td>
</tr>
<tr>
<td>Shutdown port for Apache Tomcat</td>
<td>22005</td>
<td><code>&lt;HAB_INSTALL_DIR&gt;/AppServer/InstalledApps/Tomcat/5.0.28/ApplicationBuilder/conf/server.xml</code>&lt;Server_port=&quot;portNumber&quot; shutdown=&quot;SHUTDOWN&quot;&gt;</td>
</tr>
<tr>
<td>AJP connector port</td>
<td>NA</td>
<td>NA</td>
</tr>
</tbody>
</table>

Application Builder for .NET Ports

Table 32  Application Builder for .NET Web Application Ports

<table>
<thead>
<tr>
<th>Port Type</th>
<th>Default Port Number</th>
<th>Where Configurable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Listen port</td>
<td>22080</td>
<td>EPM System Configurator</td>
</tr>
<tr>
<td>SSL listen port</td>
<td>22082</td>
<td>Application server administration console (configure manually)</td>
</tr>
<tr>
<td>Shutdown port for Apache Tomcat</td>
<td>22081</td>
<td>Application server administration console (configure manually)</td>
</tr>
<tr>
<td>AJP connector port</td>
<td>NA</td>
<td>NA</td>
</tr>
</tbody>
</table>

Financial Performance Management Applications Ports

- “Performance Scorecard Ports” on page 142.
- “Planning Ports” on page 143.
- “Strategic Finance Ports” on page 143.
- “Performance Management Architect Ports” on page 144.
## Financial Management Ports

### Table 33  Financial Management Default Service Port

<table>
<thead>
<tr>
<th>Service</th>
<th>Default Port Number</th>
<th>Where Configurable</th>
</tr>
</thead>
</table>
See the Microsoft support article describing how to set the ports used by DCOM: [http://support.microsoft.com](http://support.microsoft.com). Search for “restrict DCOM port.” |

### Table 34  Financial Management Web Server Port

<table>
<thead>
<tr>
<th>Web Server Port</th>
<th>Where Configurable</th>
</tr>
</thead>
<tbody>
<tr>
<td>80 (HTTP) or 443 (when SSL is enabled)</td>
<td>In Microsoft Internet Information Services (IIS) Manager Console, change the TCP port value setting.</td>
</tr>
</tbody>
</table>

## Performance Scorecard Ports

### Table 35  Performance Scorecard Web Application Ports

<table>
<thead>
<tr>
<th>Port Type</th>
<th>Default Port Number</th>
<th>Where Configurable</th>
</tr>
</thead>
</table>
| Listen port                            | 18080               | • EPM System Configurator  
• Application server administration console (configure manually) |
| SSL listen port                        | NA                  | Application server administration console (configure manually)      |
| Shutdown port for Apache Tomcat        | 18081               | • EPM System Configurator  
• Application server administration console (configure manually)  
**Note:** The port number depends on the listen port (listen port + 1). |
| AJP connector port                     | 18082               | EPM System Configurator  
**Note:** The port number depends on the listen port (listen port + 2). |

### Table 36  Performance Scorecard Alerter Web Application Ports

<table>
<thead>
<tr>
<th>Port Type</th>
<th>Default Port Number</th>
<th>Where Configurable</th>
</tr>
</thead>
</table>
| Listen port                            | 18090               | • EPM System Configurator  
• Application server administration console |
| SSL listen port                        | NA                  | Application server administration console (configure manually)      |
| Shutdown port for Apache Tomcat        | 18091               | • EPM System Configurator  
• Application server administration console (configure manually)  
**Note:** The port number depends on the listen port (listen port + 1). |
<table>
<thead>
<tr>
<th>Port Type</th>
<th>Default Port Number</th>
<th>Where Configurable</th>
</tr>
</thead>
<tbody>
<tr>
<td>AJP connector port</td>
<td>18092</td>
<td>EPM System Configurator</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> The port number depends on the listen port (listen port + 2).</td>
</tr>
</tbody>
</table>

### Planning Ports

**Table 37** Planning Web Application Ports

<table>
<thead>
<tr>
<th>Port Type</th>
<th>Default Port Number</th>
<th>Where Configurable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Listen port</td>
<td>8300</td>
<td>EPM System Configurator</td>
</tr>
<tr>
<td>Additional listen port (1)</td>
<td>Dynamic</td>
<td>Not configurable</td>
</tr>
<tr>
<td>SSL listen port</td>
<td>8303</td>
<td>Application server administration console (configure manually)</td>
</tr>
<tr>
<td>Shutdown port for Apache Tomcat</td>
<td>8301</td>
<td>Application server administration console (configure manually)</td>
</tr>
<tr>
<td>AJP connector port</td>
<td>8302</td>
<td>Application server administration console (configure manually)</td>
</tr>
</tbody>
</table>

**Table 38** Planning Default Service Port

<table>
<thead>
<tr>
<th>Service</th>
<th>Default Port Number</th>
<th>Where Configurable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle Hyperion Planning, Fusion Edition RMI Server</td>
<td>11333</td>
<td><code>&lt;HYPERION_HOME&gt;/common/RMI/1.0.0/HyperionRMI_Port.properties</code> Parameter: registryPort</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> If you change the port, you must run uninstallHyperionNTServiceRMI.cmd and then run installHyperionNTServiceRMI.cmd.</td>
</tr>
</tbody>
</table>

### Strategic Finance Ports

**Table 39** Strategic Finance Default Service Port

<table>
<thead>
<tr>
<th>Service</th>
<th>Default Port Number</th>
<th>Where Configurable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle Hyperion Strategic Finance, Fusion Edition Server</td>
<td>7750</td>
<td>Oracle Hyperion Strategic Finance, Fusion Edition administration tool The default port value is in the registry. The key is in HKEY_LOCAL_MACHINE\Software\Hyperion Solutions\HSFService\RPCPort. The value is a string item that contains the port number as text. Each client program includes a registry item (accessible with the Connect dialog box) to set port numbers for each contacted machine. The key for a client program connection to a server is HKEY_CURRENT_USER\Software \Hyperion Solutions\Hyperion Strategic Finance Servers&lt;machinename&gt;\NetworkPort. It is also a string that contains a numeric value.</td>
</tr>
</tbody>
</table>
## Performance Management Architect Ports

### Table 40  Performance Management Architect Web Application Ports

<table>
<thead>
<tr>
<th>Port Type</th>
<th>Default Port Number</th>
<th>Where Configurable</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Oracle Hyperion EPM Architect, Fusion Edition UI</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Listen port</td>
<td>19091 (can be configured for SSL)</td>
<td>EPM System Configurator</td>
</tr>
</tbody>
</table>
| SSL listen port | 19094 | <HYPERION_HOME>/deployments/Tomcat5/EPMAWebTier/conf/server.xml  
<Connector port="<ssl_port>" portNumber="<portNumber>" disableUploadTimeout="true" acceptCount="100" debug="0" scheme="https" secure="true" clientAuth="false" sslProtocol="TLS" algorithm="" keystoreFile="" keystorePass="JKS" keystoreType=""/>  
Parameters:  
- algorithm: certificate algorithm  
- keystoreFile: fully qualified path to the keystore file  
- keystorePass: keystore password  
- keystoreType: type of keystore, JKS is usually the default |
| Shutdown port for Apache Tomcat | 19092 | EPM System Configurator  
HYPERION_HOME>/deployments/Tomcat5/EPMAWebTier/conf/server.xml  
For parameters, see the application server documentation. |
| AJP connector port | 19093 | EPM System Configurator  
HYPERION_HOME>/Deployments/Tomcat5/EPMAWebTier/conf/server.xml  
<Connector port="<ajp_port>" portNumber="<portNumber>" protocol="AJP/1.3" enableLookups="false" debug="0"/>  
**Note:** The connector tag should be added as a child of Server->Service tag. |
| **Data Synchronizer Web Service (Performance Management Architect)** | | |
| Listen port | 19101 (can be configured for SSL) | EPM System Configurator |
| SSL listen port | 19104 | <HYPERION_HOME>/deployments/Tomcat5/EPMADataSynchronizer/conf/server.xml  
<Connector port="<ssl_port>" portNumber="<portNumber>" disableUploadTimeout="true" acceptCount="100" debug="0" scheme="https" secure="true" clientAuth="false" sslProtocol="TLS" algorithm="" keystoreFile="" keystorePass="JKS" keystoreType=""/>  
Parameters:  
- algorithm: certificate algorithm  
- keystoreFile: fully qualified path to the keystore file  
- keystorePass: keystore password  
- keystoreType: type of keystore, JKS is usually the default |
### Table 41  Performance Management Architect Dimension Server Default Service Ports

<table>
<thead>
<tr>
<th>Services</th>
<th>Default Port Number</th>
<th>Where Configurable</th>
</tr>
</thead>
</table>
| Server Manager            | 49500               | BPMA_Server_Config.xml  
<ServerManagerPort>portNumber</ServerManagerPort> |
| Process Manager           | 49501               | BPMA_Server_Config.xml  
<Port>portNumber</Port> |
| Event Subscription        | 49502               | BPMA_Server_Config.xml  
<EventSubscriptionPort>portNumber</EventSubscriptionPort> |
| Event Manager             | 49503               | BPMA_Server_Config.xml  
<EventManagerPort>portNumber</EventManagerPort> |
| Job Manager               | 49504               | BPMA_Server_Config.xml  
<JobManagerPort>portNumber</JobManagerPort> |
| Engine instances          | 51000–51999         | BPMA_Server_Config.xml  
<MinEnginePort>portNumber</MinEnginePort>  
<MaxEnginePort>portNumber</MaxEnginePort> |
| Data Access Layer (DB2 only) | Dynamic            | BPMA_Server_Config.xml  
Note: Performance Management Architect does not control which port DB2 uses. However, the port that is used by DB2 can be specified in BPMA_Server_Config.xml so that Oracle Hyperion EPM Architect, Fusion Edition can connect to the database. |

### Table 42  Performance Management Architect Web Server Port

<table>
<thead>
<tr>
<th>Web Server Port</th>
<th>Where Configurable</th>
</tr>
</thead>
<tbody>
<tr>
<td>80</td>
<td>Microsoft Internet Information Services (IIS) Manager Console. (Change the TCP port value setting.)</td>
</tr>
</tbody>
</table>
Data Management Ports

- “Data Integration Management Ports” on page 146.
- “Translation Manager Ports” on page 147.
- “FDM Ports” on page 148.
- “Data Relationship Management Ports” on page 148.

Data Integration Management Ports

Table 43   Data Integration Management Web Services Hub Ports

<table>
<thead>
<tr>
<th>Port Type</th>
<th>Default Port Number</th>
<th>Where Configurable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Listen port</td>
<td>7333</td>
<td>&lt;\WSH_HOME&gt;, update the following files:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- config/WSHConfig.xml</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- &lt;HubPortNumber&gt;\portNumber&lt;/HubPortNumber&gt;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- WSH.wsdl</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- wsdlsoap:address location=<a href="http://TCHIGATE1:portNumber/PowerCenter/services/Metadata/%3E">http://TCHIGATE1:portNumber/PowerCenter/services/Metadata/&gt;</a></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- wsdlsoap:address location=<a href="http://TCHIGATE1:portNumber/PowerCenter/services/DataIntegration/%3E">http://TCHIGATE1:portNumber/PowerCenter/services/DataIntegration/&gt;</a></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- jboss-3.2.1/server/default/deploy/jbossweb-tomcat.sar/META-INF/jboss-service.xml</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Parameter: A HTTP/1.1 Connector on port portNumber</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Note: See WebServicesProviderGuide.pdf, which is installed in /WSHub/docs.</td>
</tr>
<tr>
<td>SSL listen port</td>
<td>NA</td>
<td>jboss-3.2.1/server/default/deploy/jbossweb-tomcat.sar/META-INF/jboss-service.xml</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Parameter: SSL/TLS Connector configuration</td>
</tr>
<tr>
<td>Shutdown port for Apache Tomcat</td>
<td>NA</td>
<td>NA</td>
</tr>
<tr>
<td>AJP connector port</td>
<td>8009</td>
<td>jboss-3.2.1/server/default/deploy/jbossweb-tomcat.sar/META-INF/jboss-service.xml</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Parameter: AJP 1.3 Connector on port nnnn</td>
</tr>
</tbody>
</table>
### Table 44  Data Integration Management Default Service Ports

<table>
<thead>
<tr>
<th>Service</th>
<th>Default Port Number</th>
<th>Where Configurable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle’s Hyperion® Data Integration Management Server</td>
<td>4001</td>
<td>- EPM System Configurator (if PowerCenter Server component is installed)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- INFA Workflow Manager (installed with the PowerCenter Client component)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Native INFA PowerCenter Server Configuration Utility:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Windows: &lt;DIM_HOME&gt;/Server\binpmsetup.exe (saves server configuration to Windows registry)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- UNIX: &lt;DIM_HOME&gt;/Server/binpmconfig (saves server configuration to the &lt;DIM_HOME&gt;/Server/bin/pmserver.cfg file)</td>
</tr>
<tr>
<td>Oracle’s Hyperion® Data Integration Management Repository Server</td>
<td>5001</td>
<td>- EPM System Configurator</td>
</tr>
<tr>
<td></td>
<td>5001</td>
<td>- INFA PowerCenter Repository Server Configuration Utility:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Windows: &lt;DIM_HOME&gt;/RepositoryServer/bin\PmRsSetup.exe (saves server configuration to Windows registry)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- UNIX: &lt;DIM_HOME&gt;/RepositoryServer/binpmrsconfig (saves server configuration to the &lt;DIM_HOME&gt;/RepositoryServer/bin/pmrepserver.cfg file)</td>
</tr>
</tbody>
</table>

### Translation Manager Ports

#### Table 45  Translation Manager Web Application Ports

<table>
<thead>
<tr>
<th>Port Type</th>
<th>Default Port Number</th>
<th>Where Configurable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Listen port</td>
<td>14080</td>
<td>EPM System Configurator</td>
</tr>
<tr>
<td>SSL listen port</td>
<td>14090</td>
<td>&lt;TranslationManager_Home&gt;/AppServer/InstalledApps/Tomcat/5.0.28/HTMServer/conf/server.xml Parameter: Connector port</td>
</tr>
<tr>
<td>Shutdown port for Apache Tomcat</td>
<td>14005</td>
<td>Application server administration console (configure manually)</td>
</tr>
<tr>
<td>AJP connector port</td>
<td>NA</td>
<td>Application server administration console (configure manually)</td>
</tr>
</tbody>
</table>

#### Table 46  Translation Manager Default Service Port

<table>
<thead>
<tr>
<th>Service</th>
<th>Default Port Number</th>
<th>Where Configurable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle’s Hyperion® Translation Manager RMI Server</td>
<td>11333</td>
<td>- Oracle’s Hyperion Enterprise Performance Management System Configurator</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- &lt;HYPERION_HOME&gt;/common/RMI/1.0.0/HyperionRMI_Port.properties Parameter: registryPort</td>
</tr>
</tbody>
</table>
## FDM Ports

### Table 47  FDM Default Service Ports

<table>
<thead>
<tr>
<th>Service</th>
<th>Default Port Number</th>
<th>Where Configurable</th>
</tr>
</thead>
</table>
| File sharing | 137–139, 445 | Controlled by the operating system. Enable file sharing between all WebLink application servers and the data server and set port numbers:  
- NetBIOS Datagram Service = port 138  
- NetBIOS Name Resolution = port 137  
- NetBIOS Session Service = port 139  
If NetBIOS is turned OFF, then use SMB = port 445 |
| Firewall | 135 plus ephemeral high-range ports (1024-65536) | Windows settings—Fix DCOM ephemeral ports. For more information, see the Microsoft support article describing how to set the ports used by DCOM: [http://support.microsoft.com](http://support.microsoft.com). Search for “restrict DCOM port.” |

### Table 48  FDM Web Server Port

<table>
<thead>
<tr>
<th>Web Server Port</th>
<th>Where Configurable</th>
</tr>
</thead>
<tbody>
<tr>
<td>80 (HTTP) or 443 (HTTPS)</td>
<td>Microsoft Internet Information Services (IIS) Manager Console. (Change the TCP port value setting.)</td>
</tr>
</tbody>
</table>

### Data Relationship Management Ports

### Table 49  Data Relationship Management Default Service Port

<table>
<thead>
<tr>
<th>Service</th>
<th>Default Port Number</th>
<th>Where Configurable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle Hyperion Data Relationship Management, Fusion Edition</td>
<td>135 plus ephemeral high-range ports (1024-65536)</td>
<td></td>
</tr>
</tbody>
</table>
- config.xml using the Data Relationship Management Console  
- Windows settings—Fix DCOM ephemeral ports. For more information, see the Microsoft support article describing how to set the ports used by DCOM: [http://support.microsoft.com](http://support.microsoft.com). Search for “restrict DCOM port.” |
<table>
<thead>
<tr>
<th>Web Server Ports</th>
<th>Where Configurable</th>
</tr>
</thead>
<tbody>
<tr>
<td>80 (HTTP)</td>
<td>Microsoft Internet Information Services (IIS) Manager Console. (Change the TCP port value setting.)</td>
</tr>
<tr>
<td>443 (HTTPS)</td>
<td></td>
</tr>
</tbody>
</table>
Index

A
account list, dynamic, 108
Administration Services
default ports, 135
API Reference Guide, 129
Application Builder J2EE, default ports, 141
Application Builder.NET, default ports, 141
application conversion wizards, 130
application server
system requirements, 17
applications
compatibility between releases, 79
conversion utilities, 86
point of view, resetting, 108
requirements comparisons, between releases, 79
resetting dynamic account list criteria, 108

databases
server requirements, 15
default directories, installing to, 26
directories
component, 25
documentation
included in the installation, 123
dynamic account list, 108

E
Essbase
default ports, 134
Essbase – System 9
default ports, 134

F
FDM
default ports, 148
feature comparison, Hyperion Enterprise, 75
file server requirements, 15
files
converting, 106
Crescent, 128
Crystal, 127
HOSTS, 22
HPAPP.DAT
creating for Hyperion Retrieve, 69
LOAD.PER
saving before installation, 19
logic, converting, 106
program, 125–128
registry, 126
Windows system, 125
Financial Management
default ports, 142
Financial Performance Management Applications
default ports, 141

C
client workstations
requirements, 13
compatibility
application, 79
products, 27
complete installation, 33
conversion
utilities, 86
Crescent files, Windows, 128
Crystal files, Windows, 127
customized installation program, 69

D
Data Integration Management
default ports, 146
Data Management
default ports, 146
Data Relationship Management
default ports, 148
Financial Reporting
default ports, 138
Foundation Services
default ports, 133

H
help
Browser-Based Help for Hyperion Enterprise
Windows 32–bit client, 123
Browser-Based Help for Hyperion Enterprise
Windows 32–bit client and Web, 123
Web, 124
HOSTS file, 22
HPAPP.DAT file
creating for Hyperion Retrieve, 69
Hyperion Allocations, 129
Hyperion AutoPilot
not included in silent mode install, 31
overview, 130
Hyperion Enterprise Web Client system requirements, 16
Hyperion Enterprise Web Server
prerequisites, 23
system requirements, 16
Hyperion LedgerLink, 130
Hyperion Retrieve
icon, creating, 69
Microsoft Excel, setting up with, 69
overview, 130
setting up, 69

I
icon, creating for Hyperion Retrieve, 69
ID
Windows user, 22
installation
additional procedures, 69
complete, 33
customized, 69
Microsoft IIS Server, 23, 117
quick and silent mode, 29
regular, 33
silent, 31
uninstallation of current release, 109
workstation, 57
Interactive Reporting
default ports, 139
inventory, product, 129

L
load file conversion utility, 131
LOAD.PER file
saving before installation, 19
logic conversion utilities, 104
logic file conversion utility, 131
logic files, converting, 106

M
Microsoft Excel, setting up with Hyperion Retrieve, 69
Microsoft IIS Server, installing, 23, 117

N
notes
for quick and silent installations, 32

P
Performance Management Architect
default ports, 144
Performance Scorecard
default ports, 142
performance tuning, 120
Planning
default ports, 143
point of view, resetting, 108
ports
Administration Services, 135
Application Builder J2EE, 141
Application Builder.NET, 141
Data Integration Management, 146
Data Management, 146
Data Relationship Management, 148
Essbase, 134
Essbase – System 9, 134
FDM, 148
Financial Management, 142
Financial Performance Management Applications, 141
Financial Reporting, 138
Interactive Reporting, 139
Performance Management Architect, 144
Performance Scorecard, 142
Planning, 143
Provider Services, 136
Reporting and Analysis, 137
Shared Services, 133
Smart Search Command Line Utility, 137
Strategic Finance, 143
Translation Manager, 147
Web Analysis, 139
EPM Workspace, 140

prerequisites
Hyperion Enterprise Web Server, 23
quick installation, 19

procedures, additional for installation, 69
products
compatibility, 27
inventory, 129
program files
inventory, 125–128

Provider Services
default ports, 136

Q
quick installation, 29

R
registry files, Windows, 126
regular installation, 33–67
Reporting and Analysis
default ports, 137
requirements comparison, application, 79

S
security rights, setting up, 22
servers
databases
server requirements, 15
file server requirements, 15
security rights, setting up, 22
system requirements, 17
TCP/IP connectivity, verifying, 22
Shared Services
default ports, 133
silent installation, 31
Smart Search Command Line Utility
default ports, 137

Statutory Consolidation Engine (SCE)
overview, 130
prerequisites for installation, 21
Strategic Finance
default ports, 143
system extract conversion utilities, 104
system files, Window, 125
system requirements
application server, 17
client workstation, 13
database server, 15
file server, 15
Hyperion Hyperion Enterprise, 13
Hyperion Enterprise Web Client, 16
Hyperion Enterprise Web Server, 16

T
TCP/IP connectivity, verifying, 22
Translation Manager
default ports, 147
tuning
performance, 120

U
uninstallation
current release, 109
utilities
conversion, 131
logic conversion, 104
system conversion, 104

W
Web Analysis
default ports, 139
Web help, 124
Windows
Crescent files, 128
Crystal files, 127
registry files, 126
system files, 125
user IDs, 22
wizards, application conversion, 130
EPM Workspace
default ports, 140
workstations
client requirements, 13
installation, 57